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Preface 

Vocational Education is a dynamic and evolving field, and ensuring that every 

student has access to quality learning materials is of paramount importance.  The 

journey of the PSS Central Institute of Vocational Education (PSSCIVE) toward 

producing comprehensive and inclusive study material is rigorous and time-

consuming, requiring thorough research, expert consultation, and publication by 

the National Council of Educational Research and Training (NCERT). However, the 

absence of finalized study material should not impede the educational progress of 

our students. In response to this necessity, we present the draft study material, a 

provisional yet comprehensive guide, designed to bridge the gap between teaching 

and learning, until the official version of the study material is made available by 

the NCERT. The draft study material provides a structured and accessible set of 

materials for teachers and students to utilize in the interim period. The content is 

aligned with the prescribed curriculum to ensure that students remain on track 

with their learning objectives. 

The contents of the modules are curated to provide continuity in education and 

maintain the momentum of teaching-learning in vocational education. It 

encompasses essential concepts and skills aligned with the curriculum and 

educational standards. We extend our gratitude to the academicians, vocational 

educators, subject matter experts, industry experts, academic consultants, and all 

other people who contributed their expertise and insights to the creation of the 

draft study material. 

Teachers are encouraged to use the draft modules of the study material as a guide 

and supplement their teaching with additional resources and activities that cater 

to their students' unique learning styles and needs. Collaboration and feedback are 

vital; therefore, we welcome suggestions for improvement, especially by the 

teachers, in improving upon the content of the study material. 

This material is copyrighted and should not be printed without the permission of 

the NCERT-PSSCIVE.   

 

Deepak Paliwal 

(Joint Director) 

PSSCIVE, Bhopal 

Date: 12 September, 2024 
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Module 1 Colors in Storyboarding 

 

Module Overview  

In Class IX, we have discussed the principles of storyboards, the requirement of scripts 

and screenplays, pencil drawing techniques to create storyboard. Color is an essential 

part of story-boarding. Although, sometimes simple monochrome is sufficient, but the 

colored sketches in storyboard help to visualize a shot in a more enhanced and detailed 

manner. 

Color gives a clear meaning of shot. So, it is important to understand the basics of color 

theory. In this unit you will understand the importance of color scripts and how to use 

them in the storyboard. 

There are mainly three types of colors Primary, Secondary, and Tertiary. By using these 

colors, it is possible to manipulate the viewers with depth and bring their focus on a 

particular point. The color forms are categorized as CMYK and RGB. Moving ahead to 

understand the psychology of colors i.e. how different colors give a different impression 

on a group of people. 

Learning Outcomes 

After completing this module, you will be able to: 

• Understand the fundamental principles of color and its application in visual media. 

• Explore the psychological effects of colors and how they influence audience 

perception and emotions. 

Module Structure  

Session 1: Color Basics 

Session 2: Color Psychology  

Session 1: Color Basics 

Rita went to hill station in a holiday trip. There she saw beautiful scene of mountains, 

rivers and trees as shown in Figure 1.1. It looks more beautiful during sunrise and 

sunset. She asked her father about this. Her father said, it is the impact of sunlight that 

enhances the color hence these scenes look more beautiful. 

 
Fig.1.1 Rita is watching a sunset 
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Light and color is an essential part of any visuals. Thus, it is an important element for 

storyboarding. However, going for simple monochrome storyboard can help to reduce 

the budgets. But colors at the end tend to help visualize a shot in more enhanced and 

detailed manner. It is very powerful and can totally change the meaning of shot. 

In this chapter, you will understand about color and its perception, basics of color 

theory, the color wheel, additive and subtractive color, color relativity, color harmony, 

color tools and necessity of color in storyboarding. 

1.1 Color 

Color is a perception of light, as it reflects from objects and enter our eyes. In physics, 

color is defined as electromagnetic radiation having a specific wavelength range visible 

to the human eye. 

In the late 1600s, Sir Isaac Newton (1642–1727) performed a series of experiments 

involving prisms, light and color, which forms the foundation of color. 

In these experiments white light was refracted by a prism. Here the prism is a clear 

triangular glass object that splits white light waves into different colors. The white light 

was divided into seven different colors – violet, indigo, blue, green, yellow, orange and 

red as shown in the Figure 1.2. Prior to this observation, people thought that the prism 

colors white light, when it passes through it. To prove his argument, Newton reversed 

the process and refracted all seven colors again to the prism and produced pure white 

light. 

 
Fig. 1.2 White light passes through the prism 

1.3 Basics of Color Theory 

The art and science behind using colour is explained in the colour theory. There are two 

forms of color – CMYK (cyan, magenta, yellow, black) and RGB (Red, Green, Blue). With 

these colors, it is possible to manipulate the viewers with depth and divert their focus 

on a particular point. It is important to understand the impact of colors in storyboarding 

because it helps to depict the feel of the scene as shown in Figure 1.3. 

 
Fig. 1.3 Example of color storyboard 
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1.4 Types of Colors 

The colors are classified as primary, secondary and tertiary colors. 

1.4.1 Primary Color 

In traditional color theory, primary colors are the three color pigment that cannot be 

created by the mixture of any other colors. Basically primary color are used in paints 

and pigments. The three primary colors are – Red, Blue, Yellow are shown in Figure 1.4. 

 

Fig.1.4 Primary color 

So while painting or making any design, primary colors are used as a base color and to 

anchor any design, use general color scheme. After making any design by using basic 

colors, explore different shades, tones and tints of the color. Orange is not a primary 

color, but many brands like JBL, nick, Fanta use this as their dominant color as shown 

in Figure 1.5. 

 

Fig. 1.5 Color scheme is used by different brands 

Assignment 1.1 

In a newspaper, cut the logo of different brands and make a list of brand name and 

colors associated with it. 

1.4.2 Secondary Colors 

Secondary colors are the combination of any two primary colors as shown in Figure 1.6. 

Orange, green, and purple are the three secondary colors. These are created by mixing 

pure form of primary colors. The pure form of color is called as hue color. 

Red + Yellow = Orange 

Yellow + Blue = Green 

Blue + Red = Purple 

 

Fig. 1.6 Secondary Color 
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Assignment 1.2 

Create secondary color by mixing primary colors using color pen, paint or digital color. 

1.4.3 Tertiary colors 

Tertiary colors can be formed by mixing primary and secondary colors. They are a bit 

complex to understand because primary colors cannot be mixed with secondary colors 

randomly. For example, red cannot be mixed with green and blue cannot be mixed with 

orange. If these colors are mixed with each other, it will create brownish color. 

Observe the color wheel of secondary color as shown in the Figure 1.7. If primary colors 

are mixed with adjacent secondary colors in color wheel, then it will create tertiary colors 

as shown in Figure 1.7. 

There are six tertiary colors can be formed by mixing colours as below, 

Red + Purple = Red-Purple (Magenta) 

Red + Orange = Red-Orange (Vermilion) 

lue + Purple = Blue-Purple (Violet) 

Blue + Green = Blue-Green (Teal) 

Yellow + Orange = Yellow-Orange (Amber) 

Yellow + Green = Yellow-Green (Chartreuse) 

 

Fig. 1.7 Tertiary Color 

Assignment 1.3 

Identify and categorize colors of objects, like trees, flowers, leaf, Pencil etc. into 

primary, secondary and tertiary colors. 

1.5 The Color Wheel 

There are twelve basic colors comes after counting all the primary, secondary and 

tertiary color. But in software like Photoshop there are more color combination, which 

are used beside these twelve colors. To explain all these colors, color wheel is formed. It 

is a circle graph that charts each primary, secondary and tertiary color, as shown in 

Figure 1.8. 
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Fig. 1.8 Color wheel 

Observe this color wheel, it is based on rainbow color scale. It helps in design to visualize 

colors with the combination of other colors. 

Assignment 1.3 

Draw a color wheel on a blank paper and fill the color by using color pencil as shown 

in Figure 1.9. 

 

Fig.1.9 Blank wheel 

1.6 Color Property 

There are three common characteristics of color – hue, saturation and brightness. Figure 

1.10 represents Hue, saturation and value or brightness. 

 

Fig. 1.10 Hue, Saturation and Value 

1.6.1 Hue 

In color theory, hue represents the pure pigment without tint or shades. The common 

color name is called “Hue”. When color is used appropriately, it can guide the viewer’s 
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eyes the important scene like in the Figure 1.11, the Grey duck is from ‘ugly duck’ film 

is more important than other three yellow ducks. 

 

Fig. 1.11 Grey duck from the Ugly Duck film animation 

Colors can be used to tell the story or completely change the mood of the scene; it can 

make or break scene to get it nailed down. 

1.6.2 Color saturation 

It refers to the intensity of color in an image. Hue refers to the color of the image itself, 

while saturation describes the intensity (purity) of that hue. When color is fully 

saturated, the color is considered in purest form. Primary colors red, blue and yellow 

are considered true version color as they are fully saturated. Colors appear to be more 

pure with increasing saturation and washed-out or pale with decreasing saturation, as 

shown in Figure 1.12 (a) & (b). 

 

Fig. 1.12 (a) & (b) Saturated and de-saturated color 

1.6.3 Color value 

Color value denotes the brightness of color. It is measured by lightness and darkness of 

color. While using color, it is crucial to make the balance between color values and 

saturation. Because, most of the time highly saturated colors look artificial or fake. In 

high saturated color, viewer is not able to focus at any point in image. Meanwhile, highly 

saturated colors are useful in cartoon and animation movies, since it gives the feeling 

to viewer that something is not real. In UP animation film from Pixar such quality of 

Value can seen. Brightness and saturation can affect moods and emotions also. The 

colors used in Figure 1.13 are very vibrant. The yellow and orange is used in particular 

scene, which reflects happiness. 
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Fig. 1.13 High brightness and saturation creates happiness 

Later in the movie, the colors change to very de-saturated tone like a lot of grays, and a 

lot of browns as shown in Figure 1.14. That helps the viewer to feel coldness and the 

loneliness experiencing by characters. 

 

Fig. 1.14 Low brightness and de-saturation creates sadness 

Assignment 1.4 

Observe hue, saturation and brightness and their impact in the given animated movies 

– UP, Kung Fu Panda, Finding Nemo 

1.7 Tint, Tone and Shade 

When any color is chosen from the color scheme, color wheel helps to select the brighter, 

lighter, softer and darker color, as shown in Figure 1.15. It is done by mixing the white, 

black and gray in the base color or Hue. 

 
Fig. 1.15 Hue, tint, tone and shade 

In a fair (mela) a lot of colors spread everywhere, as shown in Figure 1.16. Here, the 

Hues of lights, shades of different balloons or similarity in the color tone of different 

shop’s name, could be easily noticed. 
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Fig. 1.16 Fair 

1.7.1 Hue 

The term “hue,” is often used interchangeably with the word “color”. It refers to the 

family to which a particular color belongs. The three primary colors red, blue and yellow, 

and three secondary colors, Orange, Violet and green are considered as hue. These are 

the base color for any mixture. 

Rose, burgundy, Magenta and candy apple all are from the red hue family. Chartreuse, 

leaf Green and sea-foam are all from green hue family, and so on. The word 

“color, ”referrers to its hue as shown in Figure 1.17. 

 
Fig. 1.17 Different Hues 

1.7.2 Tint 

In color theory, a true tint is a mixture of pure colors added only white color. A tint 

lightens the color. Here white reduce the intensity of original hue, so the original color 

looks softer. To create a true tint, simply add white to any individual color on the color 

wheel or any of those pure colors mixed together. To understand this refers the Figure 

1.18. 

 

Fig. 1.18 Different Tints 

1.7.3 Tone 

In color theory, a true tone is mixture of pure colors with only gray added. Gray should 

be truly neutral means there should not be any color mixed with gray except black and 

white. 

As the neutral mixture of gray is mixed, it will tone down the intensity of color. Mixing 

too much gray dulls the color badly. The different tones are shown in Figure 1.19. 
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Fig. 1.19 Different Tones 

1.7.4 Shade 

In color theory, a true shade is a mixture of pure colors with only black added. A shade 

darkens the color. It can be slightly dark than the original color to almost black with 

barely any of the color mixed in. Figure 1.20 to see different shades. 

 
Fig. 1.20 Different Shades 

Practical activity 1.1. Create Tint, tone and shades palette of blue color. 

Material required – A4 white paper sheet, painting colors 

Procedure 

Step 1. Draw some grid on paper and divide it in ten block as shown in Figure 1.21 

 
Fig. 1.21 Drawing blocks 

Step 2. Now paint the pure blue color on each first block as shown in Figure 1.22. 

 
Fig. 1.22 Filling blue color on first block 

Step 3. Now on the first row, gradually increase the amount of white color after 

painting each block as shown in Figure 1.23. 
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Fig. 1.23 Creating different tint of blue 

Step 4. The first palette shows the different tint that is created by adding white color 

on pure blue, as shown in Figure 1.24. 

 
Fig. 1.24 First row shows different tint 

Step 5. Adding variable amounts of black produces different shades of blue, as 

shown in Figure 1.25. 

 
Fig. 1.25 Creating different shades of blue 

Step 6. In the third row, different tones will be demonstrated. For this, first gray color 

is produced by mixing equal amount of white and black, as shown in Figure 1.26. 

 
Fig. 1.26 Mixing black and white to produce gray 

Step 7. Now Third row is showing different tones of blue as shown in Figure 1.27. 
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Fig. 1.27 Different tones of blue 

Step 8. Finally a color palette is created that have different tint, shades and tones of 

blue color. 

1.8 Additive and Subtractive Color Theory 

In the computer, the graphic programs like Photoshop, Corel Draw, illustrator are used 

different color module such as CMYK and RGB. Sometimes random number like 255, 

0, 0 are also visible. 

1.8.1 CMYK – The CMYK stands for Cyan, Magenta, Yellow and Key. Key means Black. 

These colors are used in printing process. Black ink provides depth and shades to the 

image while other colors forms different colors on the spectrum. It depends how these 

color mix with each other. CMYK is more comfortable in terms of corresponding 

numbers, CMYK works on a scale of 0 to 100. It is shown in Figure 1.28. 

When the value of C is 100, M is 100, Y is 100 and K is 100, then a black color is formed 

and when all four colors value are 0, then white color is seen in computer. 

 

Fig. 1.28 CMYK color Model 

1.8.2 RGB 

RGB color models are designed for digital displays including computers. RGB stands for 

red, green, and blue as shown in Figure 1.29. It is based on additive color model of light 

waves. This implies adding more color gets closer to white. For computers, RGB is 

formed from a scale value of 0 to 255. 

 

Fig. 1.29 RGB Color Model 
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So black is created when red is 0, green is 0, and blue is 0. Where white would be seen, 

when red is 255, green is 255, and blue is 255. 

While creating any design, any of these two color schemes RGB and CMYK can be 

selected as per the requirement. While designing for digital image or for web select RGB 

model but any design which is going for printing should be converted or designed in 

CMYK. 

Table 1.1 Differences between RGB and CMYK color Model 

RGB Color Model CMYK Color Model 

Its primary colors are – Red, Green and 

Blue 

Its primary colors are – Cyan, Magenta, 

Yellow and Black 

It is used for digital work. It is used for printing work. 

It is an additive mixing technique It is subtractive mixing technique 

Colors look more vibrant in this color 

scheme 

Colors look less vibrant in this color 

scheme 

This model has more color range It has less color range 

The file format mostly used are – jpeg, png, 

tiff. 

The file format mostly used are – pdf, eps. 

1.9 Color Relativity 

It simply means how any colors are perceived in respect to other colors. Let us study 

the impact of different pairs of color circles, as shown in Figure 1.30. 

 

Fig. 1.30 Example of color relativity 

Here four pair of circle is visible and in each pair the center of the circle is of similar 

size, shape, and color. The only change is that the background color in each pair of 

circle is different. 

The color of center circles appears brighter or darker depending upon the respective 

background color. With just a single color change, changes in movement or depth can 

be noticed. 

Color can change the perception, if pairs of color are used in a particular way. So while 

selecting any color for the storyboarding, consider the quantity of contrast kept 

throughout the planning. 

For example, if a cartoon character is to be placed behind a background, then it is better 

to use contrast background color to easily view the character, as shown in Figure 1.31. 
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Fig. 1.31 Color relativity examples 

However, choosing colors with high contrast is not always as difficult as choosing colors 

that looks good together. Finding a color combination may take so much time. As 

choosing the text and background color for an info-graphic is a difficult task. There are 

logical rules to make color schemes that work together. 

Assignment 1.6 

Observe the color relativity by overlapping two color circles and changing the color 

value of background circle. 

1.10 Color Harmony 

It means making a color combination which looks good or complements each other. 

There is definite color harmony between some colors like Red and green. When these 

colors are used it looks like they complement each other. However there are some color 

combination like Red and Blue. If such kind of color is used, then it might not look good 

or suit with the design. So, some great color harmony is discussed here. 

1.10.1 Monochromatic Color 

In monochromatic schemes, select one hue in color wheel and use its different shades 

and tints, as shown in Figure 1.32. 

 

Fig. 1.32 Monochromatic color scheme 

Although it has less contrast but often ends up looking very clean and polished. In 

monochromatic scheme, it is possible to change the brightness and darkness of the 

color could be changed easily. 

The monochromatic color schemes can be used when the contrast is not necessary. 

Figure 1.33, shows the monochromatic colors are created from the red hue. 
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Fig. 1.33 Monochromatic color Pattern Example 

Monochromatic color schemes include the shades of single color. For example in case 

red color is to be used then other shades would be dark red and pink. This scheme 

creates a deep harmonious feeling that is soft and smoothing. Hollywood movie ‘Matrix’ 

(Figure 1.34) is a good example of a monochromatic color scheme. In this movie, every 

scene has been set in a green hue. Shades of green permeate everything in the frame to 

create an unnatural, “lulling” effect. Another example of monochromatic movie is 

“Moonrise kingdom” as shown in Figure 1.35, Here different shades of yellow are used 

to show psychology of the character. 

 
Fig. 1.34 Monochromatic color scheme from movie ‘Matrix’ 

 
Fig. 1.35 Monochromatic color scheme from movie ‘Moonrise kingdom’ 

Assignment 1.7 

Create a mono chromatic color palette from given hue. (Figure 1.36) 

 
Fig. 1.36 Color 

1.10.2 Analogous Color 

In color wheel, pairing any one main color with the two adjacent colors is known as 

analogous color scheme. So, for adding five colors in this scheme, add two additional 

colors which are found next to the two outside colors. 
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Fig. 1.37 Analogous color 

Adjacent colors can be selected in the analogous structure as shown in Figure 1.37. 

They are not high contrasting colors. Hence it is useful in creating a softer, less 

contrasting effect. For example, one could use an analogous structure to create a color 

scheme with autumn or spring colors. 

This color scheme could be used to create warmer color palettes such as red, orange, 

and yellow or cooler color palettes such as purple, blue, and green as shown in Figure 

1.38. They do not create high contrast but it looks nice together. 

 

Fig. 1.38 Analogous color Pattern Example 

 

Fig. 1.39 Analogous colors in Landscape 

Analogous colors are easy to take advantage in landscapes and exteriors as they are 

often found in nature. One color can be chosen to dominate, a second to support, and 

a third (along with blacks, whites and Grey tones) to accent. 

Analogous color is easily found in nature as shown in Figure 1.39. Hence it is useful in 

creating landscape and exterior. To make background by analogous color, choose one 

dominating color, another color to support dominating color and lastly use some color 

with slightly different shades and tones to create complete environment. 

Assignment 1.8 

Collect five screenshots from the various videos or film, which is used analogous 

color scheme. 
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1.10.3 Complementary Color 

In color wheel, complementary color is placed across each other. Select two colors which 

are opposite to each other. Choose relevant tints of those colors. It provides the 

maximum color contrast. Therefore, it is best to use one color predominantly while other 

as accents in any design. Figure 1.40 shows the complementary color scheme. 

 

Fig. 1.40 Complementary color 

The complementary color scheme is best suited for creating graphs and charts. High 

contrast helps to highlight important points and texts. Henceforth use complementary 

colors in info-graphics as shown in Figure 1.41, and then choose much lighter color for 

the background. 

 

Fig. 1.41 Info graphics 

For instance, imagine an orange color in background with blue for text and accents. 

Imagine its look. Here orange will be dominated making it difficult for the reader to 

understand the text as shown in Figure 1.42. 

 

Fig. 1.42 Complementary color pattern 

In movies, complementary color combines with warm and cool color to produce a high 

contrast and tension, as shown in Figure 1.43 (a). In an animation, complementary color 

is used to focus on characters as shown in Figure 1.43 (b). 
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Fig. 1.43 (a) Complementary color 

scheme from movie ‘X-Men’ 

 

Fig. 1.43 (b) Complementary color 

scheme in movie ‘Robin hood (1973)’ 

1.10.4 Triadic color 

Triadic color provides high contrasting color schemes while retaining the same tone. 

Triadic color schemes are created by choosing three colors that are equally placed in 

lines around the color wheel as shown in Figure 1.44. For getting Triadic color scheme, 

simply place an equilateral triangle on the color wheel. The colors at each point comes 

together to make the triadic combination. 

 

Fig. 1.44 Triadic color 

To reduce the contrast of triadic color scheme, choose one dominant color and soften 

tint of other two color. It is shown in Figure 1.45. 

Examples of triadic combinations, 

Red, yellow, and blue 

Purple, green, and orange 

Blue-purple, red-orange, and yellow-green  

 

Fig. 1.45 Triadic color Pattern 

In Triadic color scheme, one color should be dominant while the others will be accented. 

Triadic is one of the least common movie color schemes, but it can be striking and 

vibrant even when the hues are unsaturated as shown in Figure 1.46. 
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Fig. 1.46 Triadic color Scheme 

1.10.5 Split Complementary color 

The split complementary color scheme is a variation of complementary color. In this 

color scheme, first select a base color then select two colors which are directly adjacent 

of the base color’s complement. By using this method, we get the combination of both 

warm and cool colors, which is easily balanced than complementary color as shown in 

Figure 1.47. 

 

Fig. 1.47 Split Complementary color 

Some example of split complementary color scheme, 

Red, blue-green, and yellow-green 

Blue, red-orange, and yellow-orange 

Yellow, blue-purple, and red-purple 

Purple, yellow-orange, and yellow-green 

It can be used in a chart or graph because it gives the contrast and the colors remain 

visually appealing. These colors can be used in an info-graphic also. See Figure 1.48 to 

learn about these colors. 

 

Fig. 1.48 Split Complementary color example 
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Assignment 1.9 

Identify the color scheme and create a color wheel for given (Figure 1.49) frame A and 

(Figure 1.50) frame B. 

 
Fig. 1.49 Frame A 

 
Fig. 1.50 Frame B 

 

To choose the correct color scheme for storyboard, first study the script and explore the 

main theme or concept of film. After that, select the color scheme for movie and use it 

in the storyboard. For example, if contrast is needed then select complimentary color, 

On the other hand, if unnatural lulling effect is to be added then select monochromatic 

scheme. 

Remember, it is not always necessary to use all the colors into a color scheme, supposed 

to create a color scheme with five colors, it is not necessary to use entire color scheme 

in the storyboard. Use only those colors which are required; it may be two, three or even 

all colors. 

1.11 Color tools 

There are different color tools available in software allows to select the color scheme 

easily and quickly. So, let us discuss about these tools. 

Adobe color 

Adobe color tool is widely used in designing and creating info-graphics or pie chart. It 

allows selecting color themes effortlessly. It is a free online tool, which helps the designer 

to quickly build color scheme based on different color structure. (Figure 1.51) 

It is simple to use these themes in the designing software. Select and copy the HEX or 

RGB code from adobe color and paste it in the program. Apart from this, explore 

hundreds of premade color. While using Adobe software, save themes in Adobe 

accounts. 

 

Fig. 1.51 Adobe color Guide 

Illustrator color Guide 

Every designer uses Adobe Illustrator. If any color is selected in foreground then color 

guide automatically generate a five color scheme. It also offers various tints and shades 

for every color scheme. So let us try to perform it in Adobe Illustrator. 
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Open Adobe Illustrator and create new file. 

Select a base color by using color picker (Figure 1.52) and click OK. 

 
Fig. 1.52 Select base color using color picker 

Color is displayed in foreground, as shown in Figure 1.53. 

 

Fig. 1.53 Foreground color 

To enable color guide, select Windows > Color Guide or press Shift+F3, as shown in 

Figure 1.54. 

 

Fig. 1.54 Enable color guide 

Now click on pull-down to display different color schemes, as shown in Figure 1.55. 

 

Fig. 1.55 Different color scheme 

Select any color theme from color guide. If primary color is changed, the color guide will 

change the corresponding color in the scheme. For example, if base color is changed 

from red to yellow, the complimentary color will be shifted in purple and blue, as shown 

in Figure 1.56. 
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Fig. 1.56 Complimentary color of Yellow 

Like Adobe color, the color guide has several preset modes for selecting the sort of color 

scheme. This helps to decide the proper combination style within the program that is 

already in use. 

Once color scheme is created, save that scheme within the “color Themes” module to be 

used throughout project or within the future. 

Preset color Guides 

While using Microsoft office all these options are available. All office products have 

preset colors which can be used simply. For example, in Microsoft Power Point, various 

combination of preset color is available as shown in Figure 1.57. 

 
Fig. 1.57 Preset color Guide 

There are lots of theories which are used in creating color presets. These color presets, 

helps to make branding image easier, especially when using design templates to 

customize the color. 

1.12 Color Boards 

Color boards or color storyboards translate mood and emotions into communication, 

adding the magic touch of lighting. The compositional drawing and staging unfold the 

action, adding the rhythm of the script to the movement of the camera as shown in 

Figure 1.58. 
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Fig. 1.58 Examples of color boards from TV commercial 

Always emphasize the expression and performance of the characters, whatever a 

comedy narrative or an action scene, explore multiple solutions in order to find correct 

execution-style. 

1.13 Necessity to color a Storyboard 

Colors can speak or express different emotions. Colors have a great power in expressing 

stories. They can express emotions; they can inspire and sometimes can describe whole 

story in a limited time. For example, the girl in the red coat is the most obvious symbol 

in Schindler’s List as shown in Figure 1.59, because her coat is the only color object and 

she represents the innocence of the Jews being slaughtered. 

 
Fig. 1.59 Stills from movie Schindler’s list 

Before deciding the colour in storyboard consider the most effective colour options and 

its impact in the story. 

Coloring on a storyboard is an essential element to visualize an image; however, the 

case may vary for different scenarios. 

• Television animations do not require colors in storyboard due to factors including 

time and budget. Some experts also say that in television animation storyboards, 

it is enough to make some moderately adjusted drafts, as shown in Figure 1.60. 

 
Fig. 1.60 American fiction TV series ‘West world Season 2’ Storyboard 
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• For Feature Animation, color must be added to storyboard, just to create an 

atmosphere for a scene, as shown in Figure 1.61. 

 
Fig.1.61 Animation film ‘Kung Fu Panda’ Storyboard 

• For advertising storyboards, it would be great if it is done because marketing needs 

best foot to sell anything. 

• For cinematic game storyboards, coloring is needed especially for presentation 

purpose. 

• Game storyboard requires in-depth details regarding its graphics. So here it is 

essential to add colors in storyboard. 

Most of the storyboard artists prefer drawing random sketches for story-boarding, using 

Grey and black tones on a canvas. It is easier to do this by using digital technologies 

like sketchbook and Photoshop. But these panels are initially the first draft of story-

boarding. 

Summary 

• In Storyboards, colors help to visualize a shot in more detail. 

• People can perceive any color, only in the presence of light. 

• Hue, saturation and values are used to create environment and fills emotion into 

the storyboard. 

• Color Theory explains how to mix, match or create contrast from the color. 

• Color wheel is graph that charts primary, secondary and tertiary color. 

• Tint, tone and shades of any color could be changed by mixing white, gray and 

black into color respectively. 

• CMYK color is mostly used in printing whereas RGB color model is used in digital 

display. 

• Color relativity describes the perception of color with respect to other colors. 

• Color harmony allows to experiment with different color combinations. 

• Complementary color provides maximum contrast and is widely used in animated 

film. 

• Color guide tools such as Adobe and Illustrator color allow the designer to choose 

a color scheme easily and quickly. 
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Check Your Progress 

A. Multiple Choice Questions 

1. Sir Isaac Newton performed and published a series of experiments involving, (a) 

light and color (b) prism and light (c) light and color (d) prism, light and color 

2. Color theory is basically the art and science of using (a) color (b) light (c) shadow 

(d) gradient 

3. These are the primary colors used in paint and pigment (a) Red, Green, Blue (b) 

Red, Blue, Yellow (c) Cyan, Magenta, Yellow, Key (d) Red, magenta, Cyan 

4. Combination of Red and Blue creates (a) Orange (b) Green (c) Purple (d) Yellow 

5. Primary color is mixed with adjacent secondary color, then it forms (a) primary 

(b) secondary (c) tertiary (d) complementary 

6. in CMYK printing, black ink provides (a) color and depth (b) color and shades (c) 

depth and Shades (d) brightness and contrast 

7. In this color scheme, select one hue in color wheel and use its different shades 

and tints (a) analogous color (b) triadic color (c) monochromatic color (d) 

complementary color 

8. Analogous colors are easily found in___ (a) artificial object (b) Nature (c) printing 

(d) house hold items 

9. What tremendous narrative power does the color have? (a) It can express speed 

and direction (b) It can express emotions, clarify motivation, and even dictate the 

whole meaning of a bit (c) It can clarify the pact of story writing (d) It distracts 

audience focus 

10. Television animation does not require colors, because of the factors including (a) 

time and budget (b) broadcast (c) signal lost (d) location 

B. Fill in the blanks 

1. Colors helps to ______ a shot in more enhanced and details. 

2. The common characteristics of the colors are Hue,______ and Brightness. 

3. If we mix red and purple then the resulting color will be_____. 

4. Color wheel is a circle graph that charts each _____, secondary and _____ color. 

5. In color wheel, pair of one main color with the two adjacent colors is 

called_______. 

6. Triadic color provides high ____color schemes while retaining the same tone. 

7. In Adobe illustrator, if selecting any foreground color, then color guide 

automatically generates _____ for you. 

8. Once the color is filled in your storyboard, it becomes_____. 

C. True or False 

1. Hue refers to the intensity of color in an image. 

2. There are five tertiary colors in color wheel. 

3. A tint lightens the color. 

4. When the value of C is 100, M is 100, Y is 100 and K is 100, then you will see a 

white color. 
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5. Color Relativity means perception of colors in contrast to other colors. 

6. Complementary color provides minimum color contrast. 

7. To reduce the contrast of triadic color scheme, choose one dominant color and 

soften tint of other two colors. 

8. For advertising storyboards, you have to create a neat, clean and detailed 

storyboard. 

D. Short Answer Questions 

1. Explain the narrative power of color in story-boarding? 

2. What are hue, saturation, and value? Explain in detail. 

3. What is color theory? 

4. Explain the fundamentals of colors. 

5. Differentiate between primary and secondary colors. 

6. Write a short note on Tertiary colors. 

7. Explain the color Wheel. 

8. Define the term hue, tint, tone and shades? 

9. What is additive and subtractive color theory? 

10. What are adobe colors? 

11. Write the importance of color in a storyboard? 

 

 

Session 2: Color Psychology 
 

Sunny and her friends went to the cinema hall to watch a horror movie. (Figure 2.1) In 

the middle of the film, Sunny was so scared that he rushed out of the cinema hall. It is 

because of the darkness, sound effects, frightening characters and colors. 

 

Fig. 2.1 Sunny is watching horror movie in cinema hall 

In this chapter, you will understand the psychological impact of different colors in film 

storytelling and the use of color script in animation movies. 

2.1 Psychology of color 

Study of hues, color effects and perceptions is known as color psychology. The effect of 

color on every individual is different. Artists and interior designers strongly believe that 
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color can dramatically affect moods, feelings, and emotions. For example red color 

invoke nervousness while blue color of sea makes feel calm and relaxed. Color is a 

powerful communication tool and can be used to signals action, affect mood, and even 

physical reactions as shown in Figure 2.2. 

 

Fig. 2.2 Different movie stills showing psychology of color 

Within the initial phase of psychology improvement, a famous theory of colors and 

emotions called "rose of temperament” combining twelve colors with human 

characteristics. For example adventurers, lovers, poets, historians, teachers, 

philosophers grouped into the four temperaments-sanguine, melancholic, choleric and 

phlegmatic, as shown in Figure 2.3. 

 

Fig. 2.3 Rose of Temperament 

The relation between color and human temperament is shown in Table 2.1. 

Table 2.1 Temperament and Characteristics (Rose of Temperament) 

Temperament Color Human Characteristics 

sanguine Yellow, Green and Cyan Lovers and Poet 

melancholic Violet, Magenta and Red Rulers and Philosophers 

choleric Yellow, Red and Orange Hero and Adventurer 

phlegmatic Cyan, Blue and Violet Historians, Teachers and Public speakers 

2.2 Psychological Impact of Different colors in Film Storytelling 

Generally red color is used in films for showing passion, horror and violence, while green 

represent nature, immaturity and sometimes darkness and danger. Most of the time 

while watching movies, viewer do not realize that color is playing with their emotions. 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

27 

This implies, in film storytelling, color impacts the audience psychologically and even 

physically. With the help of color, a film maker can build harmony or tension within a 

scene. 

When telling a story, colors can impact in following ways, 

• It effects the psychological reactions with audience. 

• It can draw attention to important details. 

• It is used to set the tone of the film. 

• It is used to represent specialty of the character. 

• It shows changes in the story, such as flash back. 

Now, let’s look at the impact of different colors. 

2.2.1 Green –  “Concentration” 

Forest gives a feeling of rest and calm. It also improves efficiency and focus. It is all due 

to its green color. Green is a superb color for improving concentration. It is one of the 

soft colors on the eyes. It reminds of the nature. 

Studies have shown that people, who are working in green offices, have higher rates of 

job satisfaction. Even the green painted shopping stores attracts more consumers. They 

even spend more time on purchasing in these stores. 

In film different green shades are used to show nature, immaturity, corruption, 

darkness and danger as shown in the Figure 2.4. 

 

Fig. 2.4 Psychological impact of green color in various films 

Assignment 2.1 Make a list of green objects and write about your reactions and 

thoughts when you see them. 

2.2.2 Orange – “Mood lifter” 

The sunset on horizon is seen in orange color. Orange is a welcoming and stimulating 

color for learners that promotes comfort and improve neural function. 

Some theorist argue that living in orange rich environment increases oxygen supply to 

the brain, stimulate mental ability and reduce the barriers between people. Due to 

increased oxygen level in body, person feels revitalized. But, orange is not always 

beneficial for all. Young and energetic people should avoid this color because it could 

make him over stimulated. 

In movies, orange color is used to show sociability, happiness, warm relation, young 

and glamour as shown in Figure 2.5. 
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Fig. 2.5 Psychological impact of orange color in various films 

2.2.3 Blue – “Productivity” 

Blue is best used for challenging learning situation. Blue paper, blue ink, or blue 

highlighting can be used to help improve reading comprehension. Blue is excellent for 

promoting high levels of thinking, but an excessive amount can create a way of 

detachment and coldness. 

In movies, blue symbolizes isolation, passivity and calmness. The shades of blue shows 

coldness and sadness as shown in Figure 2.6. 

 

Fig. 2.6 Psychological impact of Blue color in various films 

2.2.2 Red – “Alertness” 

Red is the most attractive and exciting color in electromagnetic spectrum. It grab the 

people’s attention or use it as a caution likes traffic signal, fire extinguisher. However, 

Excessive use of this color can cause a negative emotional response. 

In movies, different shades of red color is used to denote love, passion, violence and 

anger as shown in Figure 2.7. 

 
Fig. 2.7 Psychological impact of Red color in various films 

2.2.4 Yellow – “Happiness” 

This is the actual color of happiness and optimism. Smiles are always shown in this 

color. This color is best utilized in small quantities. An excessive amount of yellow will 

be overwhelming. Therefore, it should not be used in dominant colourize scheme. 
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In cinema, different shades of yellow color is used to demonstrate feelings of happiness 

and relaxation as well as jealousy, madness, sickness and betrayal as shown in Figure 

2.8. 

 

Fig. 2.8 Psychological impact of Yellow color in various films 

2.2.5 Grey 

It is a stable and timeless that communicates strength, robustness and longevity. Gray 

colored items have the identical attributes like steel, concrete, stone, and many more. 

Practical Activity 2.1 – Find out the impact of colors. 

Material Required – Smartphone, computer, Photo editing app such as Adobe 

Photoshop. 

Procedure 

Step 1. Divide all the students of the classroom in 4 groups. 

Step 2. Now ask the group to choose any color from Red, blue, green and yellow and 

orange. 

Step 3. After selecting the color by the group, send them to the campus for exposing 

the photos. These photos must include the color assigned. 

Step 4. Now collect the photos from all the groups and make separate folder on 

computer according to group and color assigned. 

Step 5. Preview these photos to all students and list the feelings like happiness, 

sadness, calmness, Fear and many more. Count the numbers. 

Step 6. Now ask all groups to change the color of the exposed photo by using photo 

application such as Picsart, adobe Photoshop express, snap seed etc. 

Step 7. Now again save all the photos in the computer and preview the photos. 

Step 8. Make a list again about the feeling and count the numbers again. 

Step 9. Finally analyze the result based on color and associated feelings. 

 

Assignment 2.2 

Select any movie from these three genre-patriotism, action and comedy. Watch the 

selected movie and write down any one scene, its color theme, feeling and emotions 

related to color. 

2.3 Colors of Superheroes 

Most of the super heroes appear in the three primary colors – Red, Yellow and Blue. 

They are generally good guy, fighting against monster or bad guys. 

The color Red is a warm color. The red color increases the blood pressure, fighting 

instincts and it is more incorporated with law and order. 
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The Blue color is a cool color. It indicates the calmness, focus and clarity of the 

character. 

The Yellow color is one of the most widely used colors for superheroes. It is a long 

wavelength color. It is used as a symbol of good thought and confidence that the 

superhero is to reflect. 

These primary colors are used for superheroes while black or dark grey is used on 

villains as shown in Figure 2.9 and Figure 2.10. 

 
Fig. 2.9 colors used for Super heroes and villain 

 
Fig. 2.10 Primary colors is used in Superman costume 

Assignment 2.3 

Collect the photographs or miniatures of the superheroes and villains. Make a chart 

of their costume color. 

2.4 The color Psychology behind Art and Animation 

Color psychology has a great impact on day to day life also. Red color can trigger heart 

beat and subsequently increase adrenaline in many people. Hence interior decorators 

never suggest to use red color in bedroom, instead they suggest blue or green color 

which are more related to calmness and relax. According to psychological effect, colors 

can be divided into two main categories – cool colors and warm colors. 

2.4.1 Cool colors 

In color theory, cool colors are considered in the blue-green and blue-violet ranges, 

including most grays. As mentioned, blue and green create a feeling of peaceful, calm 

and relaxation. 

2.4.2 Warm colors 

Red, yellow, brown, and tan are considered warm colors. Generally, their effect is to 

arouse and stimulate. 
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Many restaurants use red color in their branding to cause some people’s stomach’s 

growl as shown in Figure 2.11. 

 

Fig. 2.11 Red color is used for branding restaurant 

Nature always has a balance of cool and warm color. In any work, lack of warmth will 

make a piece seem lifeless. Too much warmth will appear garish as shown in Figure 

2.12 and Figure 2.13. 

 
Fig. 2.12 Warm and Cool color 

 
Fig. 2.13 Combination of warm and cool color in nature 

Table 2.2 shows color guide showing the relation between colors with emotions. 

Table 2.2 Color guide 

Color and Emotions Color Palette 

Green – healing, soothing, perseverance, tenacity, 

self-awareness, proud, unchanging nature, 

environment, healthy, fertility, jealousy, inexperience, 

envy, as shown in Figure 2.14.  
Fig. 2.14 Green 
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Orange – humor, energy, balance, warmth, 

enthusiasm, vibrant, expansive, flamboyant, as 

shown in Figure 2.15. 
 

Fig. 2.15 Orange 

Blue – Faith, spirituality, contentment, loyalty, 

fulfillment peace, tranquility, calm, stability, 

harmony, unity, trust, truth, confidence, as shown in 

Figure 2.16.  
Fig. 2.16 Blue 

Red – Anger, passion, rage, desire, excitement, 

energy, speed, strength, power, heat, love, 

aggression, danger, fire, blood, war, violence, as 

shown in Figure 2.17.  
Fig. 2.17 Red 

Yellow – Wisdom, knowledge, relaxation, joy, 

happiness, optimism, idealism, imagination, hope, 

sunshine, summer, dishonesty, cowardice, betrayal, 

jealousy, covetousness, deceit, illness, hazard, as 

shown in Figure 2.18. 

 
Fig. 2.18 Yellow 

Pink – love, innocence, healthy, happy, content, 

romantic, charming, playfulness, soft, delicate, 

feminine, as shown in Figure 2.19. 
 

Fig. 2.19 Pink 

Purple/violet – Erotic, royalty, nobility, spirituality, 

ceremony, mysterious, transformation, wisdom, 

enlightenment, as shown in Figure 2.20. 
 

Fig. 2.20 Purple 

Brown – materialistic, sensation, earth, home, 

outdoors, reliability, comfort, endurance, stability, 

simplicity , as shown in Figure 2.21. 
 

Fig. 2.21 Brown 

Black – No, power, sexuality, sophistication, 

formality, elegance, wealth, mystery, fear, anonymity, 

unhappiness, depth, style, evil, sadness, remorse, 

anger, as shown in Figure 2.22.  
Fig. 2.22 Black 

White – Protection, love, reverence, purity, simplicity, 

cleanliness, peace, humility, precision, innocence, 

youth, birth, good, sterility, cold, as shown in Figure 

2.23.  
Fig. 2.23 White 
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Silver – riches, glamorous, distinguished, earthy, 

natural, sleek, elegant, high-tech, as shown in Figure 

2.24. 
 

Fig. 2.24 Silver 

Gold – Precious, riches, extravagance. warm, wealth, 

prosperity, grandeur, as shown in Figure 2.25. 

 
Fig. 2.25 Gold 

2.5 Color Script 

A color script is a sequential visual outline. It is a highly experimental process. In this 

process, story is important. Therefore select the color, which serve large picture of the 

story. 

Basically color script is an animation term, which has popularized by Pixar studio. It is 

quite valuable tool for them. It is an early attempt to map out the color, lightening, 

emotion and moods in film. 

Color Script is not about creating a single piece of art, it involves throughout the initial 

stage of the film and updates as the story developed. 

Here we can see all the in-depth details from the high-resolution photos released by 

Disney/Pixar for Toy Story 3, as shown in Figure 2.26 (a) & (b). 

The color script of Toy Story 3 was created by Pixar’s art director, Dice Tsutsumi. This 

color script was later used by other animators to get a good understanding about, how 

the color arc in a film relates to story. 

  

Fig. 2.26 (a) & (b) color Script ‘Toy Story 3’ 

2.5.1 Importance of color scripts 

• Provide a road map for shifts in color, lightening, emotion and moods in film, 

which helps to visualize the complete movie. 

• Color script enables the director to see the film in a better way. 

• It helps the animation studios to develop their ideas and figures out different 

perspectives of the story they are telling. 

• Allows mapping out the experience from start to finish. 

• To keep look and feel consistent. 

• Shows what the final film look is support to be like. 
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2.5.2 Creating a color script 

For creating a color script foremost drawing skill and color sense must be improved. For 

this, make a goal of creating a new color scheme every day and utilize this scheme in 

drawing something. 

There is definitely a science behind selecting any color for a movie that leads the viewer 

to get more attractive and psychological impact. To understand it refers to the color 

script of the movie ‘UP’, shown in Figure 2.27. 

 

Fig. 2.27 Color script for ‘UP’ by Lou Romano 

RATATOUILLE (2007) 

Production designer Harley Jessup likes to utilize the contrasting textures of different 

locations in the films he has worked on like Monsters, Inc. and Ratatouille. His color 

script for Ratatouille emphasized the damp underground sewers against the warm, rich 

tones of the human world that Remy yearned to be a part of Amid Amidi as shown in 

Figure 2.28. 

 
Fig. 2.28 Color script for ‘Ratatouille’ by Amid Amidi 

Summary 

• Psychology is the study of human mind and its functioning, whereas color 

psychology focus on effects of colors and perceptions. 

• In a feature or animated film color is used to draw attention to important details 

and it also affects psychologically. 

• Green is used in the film to represent nature, immaturity, darkness and danger. 
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• Yellow and Orange reflects happiness, warm relation while sometimes yellow is 

also used to show jealousy, madness, sickness. 

• Blue color is best used for challenging, learning situation. In movie, blue is 

symbolized isolation, passivity and calmness. 

• Primary colors are used for superheroes and secondary colors are used for villains. 

• Cool colors such as blue-green and violet may make someone feel peaceful, calm 

and relax whereas warm color red, yellow and brown are used to arouse and 

stimulate. 

• In animation film, color script is used to decide color theme of the movie. 

 

Check Your Progress 

A. Multiple Choice Questions 

1. Study of hues, color effects and perception is known as (a) human (b) color 

psychology (c) human behavior (d) emotional effect 

2. Red color is used in film for showing (a) calmness (b) Fear (c) love (d) joy 

3. When telling a story, colors is used to (a) draw attention (b) slowing down the 

pace of film (c) show physical impact (d) designing sets 

4. In movies, green is used to show (a) immaturity, darkness and danger (b) 

happiness and warm relation (c) passivity and calmness (d) love and passion 

5. Red color can actually increase a person’s (a) concentration (b) heart rate (c) 

physical activity (d) anger 

6. This color is used as stable and timeless that communicates strength, robustness 

and longevity (a) black (b) white (c) grey (d) green 

7. Most of the superheroes costumes colors are (a) primary (b) secondary (c) tertiary 

(d) triadic 

8. Many restaurants use____ in their branding, it’s actually been shown to cause 

some people’s stomachs growl (a) blue (b) red (c) green (d) yellow 

9. What do you call a sequential visual outline that is used to colourize animated 

movie? (a) a color script (b) storyboard (c) screenplay (d) shooting script 

10. The color scripts (a) provide a road map for shifts in color, lightening, emotion 

and moods in film (b) is a way to make the director see the film in better way (c) 

allow mapping out the experience from start to finish (d) shows the final output 

of the film. 

B. Fill in the blanks 

1. Human mood is often influenced by color, light and also the _____. 

2. Green is a superb color to improve _______. 

3. Orange is a_____ color for learners. 

4. Blue is best used for challenging_______. 

5. Smiles are always in______ color. 

6. Most of time, secondary colors are used in ________ costume. 

7. In color theory, cool colors are considered in the blue-green and ______ ranges, 

including most grays. 
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8. Color Script shows your intention that how you use color in a _____film. 

C. State whether True or False 

1. Famous theory of colors and emotions is called "rose of temperament.” 

2. In film storytelling, color impacts the audience psychologically and even 

physically. 

3. Young and energetic people should avoid pink because it makes you over 

stimulated. 

4. In movies, Blue symbolizes isolation, passivity and calmness. 

5. In cinema, yellow is demonstrating feelings of happiness and relaxation as well 

as jealousy, madness, sickness and betrayal. 

6. Blue, green and violet is considered as warm color. 

7. color Script helps the studio to evolve their ideas and figures out of different 

approaches to the story they are telling. 

D. Short answer questions 

1. Explain the Psychology of color. 

2. What is psychological impact of different colors in Film storytelling? 

3. Explain the psychological impact of following color-Green, Orange, Blue and 

Red. 

4. What color are used in superheroes costumes? 

5. What colors are used in villain costumes? 

6. Write the difference between cool and warm color? 

7. What do you understand by symbolism in the color script? 

8. By what properties you can amplify the emotion in your color script? 

 

 

Module 2 

 

 

Digital Storyboarding 

 

Module Overview 

 

Pen, pencil and paper are the basic tools for creating a storyboard. But now with 

advancements in technologies, it is possible to do this digitally. It is required to just 

keep the palm on touch-pad draw and render sketches directly from the software. 

In this unit, you will understand the importance of the software for crating storyboard 

and how to create a storyboard by using software. From opening of the document with 

software to importing and setting up the field for the actual animation until the export 

and rendering stage will be discussed. Light plays an important role in colors. A variety 

of lighting techniques are used to influence the overall ambiance of the scenario. The 

software to create storyboard such as Storyboarder, Adobe Photoshop and Toon Boom 

Storyboard Pro are discussed. 
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Learning Outcomes 

After completing this module, you will be able to: 

• Explore various digital software tools used for creating professional storyboards. 

• describe learn the workflow and features of the Storyboarder software for creating 

digital storyboards. 

• Demonstrate Photoshop tools and techniques to design and refine storyboards 

digitally. 

• explore an overview of Toon Boom Storyboard Pro and its features for creating 

industry-standard storyboards. 

• Various advanced techniques in Storyboard Pro for creating detailed and dynamic 

storyboards. 

• Demonstrate Learn how to apply color effectively to storyboards using Photoshop, 

enhancing visual storyboarding. 

 

Module Structure 

Session 1. Digital Storyboarding Software 

Session 2. Digital Storyboarding in Story boarder 

Session 3. Digital Storyboarding in Photoshop 

Session 4. Introduction to Toon Boom Storyboard Pro 

Session 5. Digital Storyboarding in Storyboard Pro 

Session 6. Coloring Storyboard in Photoshop 

Session 1. Digital Storyboarding Software 

Mayank, a painting artist uses canvas with lot of colors for painting. Now, he wants to 

upgrade his skills and become a digital artist. So he is searching the software required 

for digital painting. (Figure 1.1) 

 

Fig. 1.1 Mayank is searching for requirement of digital artist in internet 

In this chapter you will understand the requirement for digital storyboarding software 

such as Storyboarder, Adobe Photoshop, Storyboard pro and Storyboard That.   

1.1 Hand drawn storyboarding 

The classic storyboards were made with drawing by hand and sketching figures as 

shown in Figure 1.2. The storyboard may not be able to convey the detail story but it 

should be able to convey actions. 
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Fig. 1.2 Hand drawn storyboard 

A hand drawn or manual story-boarding is cost effective and free. It requires only paper 

and pencil. But it is a time-consuming process and require time to draw a single shot 

even if it is not in detail. A single storyboard frame represents six seconds of video. So, 

for a three-minute video, 30 storyboard frames are needed. There is also the risk of 

losing storyboard because entire work is tied to a piece of paper. It also requires lot of 

sketching work on paper and then to scan each sketch. It is still preferred as low cost 

method. 

Assignment 1.1 

Create a line art based storyboard of each and every shot given below of a story “Lion 

and a mouse.” 

Storyline: 

Shot 1. A lion is sleeping in a forest. 

Shot 2. A mouse started playing on him. 

Shot 1. The lion was disturbed and arose from his sleep. 

Shot 4. It caught up the mouse angrily and tried to crush it to death. 

Shot 5. Then, the mouse prayed the lion to leave him off. 

Shot 6. Mouse assured the lion that he would help him when needed. 

Shot 7. The lion laughed at him and let him off. 

Shot 8. One day, the lion was caught in a net spread by a hunter. 

Shot 9. It roared and tried to escape but in vain. 

Shot 10. The mouse heard the lion's roaring and came there. 

Shot 11. It started cutting the net with its teeth. 

Shot 12. The lion escaped and thanked the mouse 

1.2 Digital Story-boarding 

Storyboards were initially made on a piece of paper, but now the advanced software and 

digital devices help to shape the imagination and visualization that look impossible 

before, as shown in Figure 1.3. 
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Fig. 1.3 Digital Pen and Tablet 

Rapid growth in technology impacts story-boarding software also. It became very easy 

to draw digitally, whenever or whatever needed. It also improved the feel and speed while 

working. 

The story-boarding software has resolved many problems, which were common while 

creating storyboard on paper with pencil. It will give the same feeling as you are drawing 

with a pencil on paper. There are many software programs that can use to create a 

storyboard. 

1.2.1 Hardware requirement for Digital Storyboarding 

To create storyboard, a computer with latest specifications with minimum Intel i5 

processor, 8 GB RAM, 1 TB HDD, 4 GB Graphics Card, digital tablet with Windows 10 

operating system installed is preferred. (Figure 1.4) 

 

Fig. 1.4 Storyboarding computer Setup 

1.3 Popular storyboarding software 

Storyboard software has advance automation and customization features. Some of them 

are discussed below. 

1.1.1 Storyboarder 

It is free and open source software (FOSS) developed by Wonder Unit. Storyboarder 

makes visualizing a story as easy as creating stick figures. Here, the idea can be tested 

and if it works then convert it into an animatic to show it to others. Express story idea 

without making a movie with Storyboarder software shown in Figure 1.5. 
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Fig. 1.5 Storyboarder software 

Features of Storyboarder 

Fast and Simple – Storyboarder is designed to be easy to use. It provides the tools to 

quickly construct storyboards. 

Simple drawing tools – It has six simple drawing tools. Light pencil is used for roughing, 

hard Pencil for fine lines, pen for most work, brush to tone, note pen to write notes, and 

eraser is used for erase the mistakes. 

Add storyboards with a click – Here board can be added in a single click. 

Storyboard can be easily copy, paste and rearrange according to requirements. 

Enter dialogue and action – Add metadata for a board on the right panel. Timing 

information and shot type can also be added. 

Click edit in Photoshop – Draw your roughs and do layout in Storyboarder. If you need 

more control, just click on edit in Photoshop button. 

Figure 1.6 shows the user interface of Storyboarder software. 

 

Fig. 1.6 User Interface of Storyboarder 

Practical Activity 1.2. Create a storyboard by using Storyboarder software. 

Material Required – Computer with digital pad and pen, Storyboarder software 

Procedure 

Step 1. Open storyboarder software, by clicking on software thumbnail. A welcome 

screen will appear. Click on, ‘Create New Storyboard’ tab, as shown in Figure 1.7. 
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Fig. 1.7 Welcome screen 

Step 2. Now a popup window opens with two options to create – Based on script and 

Blank storyboard as shown in Figure 1.8. Select second option Blank storyboard for 

creating a storyboard. 

 

Fig. 1.8 Select an option to create storyboard 

Step 1. Clicking on ‘Blank Storyboard’, open a new popup window.Select aspect ratio 

and browse the location to create a project as shown in Figure 1.9 & 1.10. 

 

Fig. 1.9 Select Aspect Ratio 

 

Fig. 1.10 Select appropriate location to save the project 

Step 4. Press the create button to open software interface as shown in Figure 1.11. 
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Fig. 1.11 Storyboarder software Interface 

Step 5. User interface is divided into 4 panels – Brush tools, Sketch Panel, Board 

Drawer, and Metadata Panel as shown in Figure 1.12. 

 
Fig. 1.12 Different Panels 

Step 6. Select the brush tool, and start sketching according to scene, as shown in 

Figure 1.13. 

 
Fig. 1.13 sketch first scene 

Step 7. Select the new panel and create another scene. In this way create multiple 

panel according to script, as shown in Figure 1.14. 
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Fig. 1.14 Create all the scenes 

Step 8. Once storyboarding is completed, press Ctrl+P to print or export storyboard 

in PDF as shown in Figure 1.15. 

 

Fig. 1.15 Export the Project 

Step 9. Once setting is completed, click on Export PDF tab to save the storyboard 

in .pdf format. 

1.2.1 Adobe Photoshop 

It is the most robust and versatile, professional software for creating illustrations and 

storyboards. Figure 1.16 shows the user interface of Adobe Photoshop software. 

 
Fig. 1.16 Photoshop interface 
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Frame sizes and aspect ratios for film and video can be easily selected in Photoshop. 

The artist may also work on layer panels using this software. It has an Art Board feature 

used to create storyboards for movies and animations. 

1.2.2 Toon Boom Storyboard Pro 

Storyboard Pro is the another most powerful and leading industry software particularly 

designed to create storyboard. (Figure 1.17) It is widely used in production studios as it 

is purely compatible with all the standards of Pre-Production project. This software gives 

creative freedom to storyboard artists. 

 
Fig. 1.17 Toon boom storyboard Pro software 

In Storyboard Pro, a storyboard artist can easily create a wide range and variety of works 

like drawing, 2D and 3D animation, stop motion and animatic. It has all the required 

tools for drawing. Following features are included in Storyboard pro. 

• Pencil 

• Various types of textured brush 

• An incorporated camera similar to those in 3D modeling software, 

• Timeline for animation and timing control 

• Sound editing tools. 

• Transition effects to set between shots 

This software can integrate imported 3D models if needed. Figure 1.18 shows the user 

interface of Storyboard pro software. 

 
Fig. 1.18 User interface of Storyboard Pro 

1.2.3 Storyboard That 
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Storyboard That is an online storyboard software that provides user a straight forward 

service. (Figure 1.19) It enables to create cartoon storyboard by using range of 

backgrounds, characters from their large library assets. 

 

Fig. 1.19 Storyboard That 

1.2.1.1 User Interface 

It is really easy to create storyboard using Storyboard software. You need to select assets 

from top of the page and drag them to the template below. It is a very intuitive interface 

which is easy to understand and useful for different levels of users. Figure 1.20 shows 

the user interface of StoryboardThat software. 

 

Fig. 1.20 Use interface of Storyboard That 

Storyboard That not only allow to create traditional, linear storyboard layouts like a 

comic strips as shown in Figure 1.21, but also enable to create mind maps and 

timelines. This provides user flexibility and expands the content creation possibilities. 

 

Fig. 1.21 Different Storyboard Layout of Storyboard That 

The most interesting things are the variety of characters and their poses. It is possible 

to change the expression of the character by choosing range of expression and emotions 

and also customize the view from front or back to right or left to have full control over 

head, arm and position. This is not just an entertaining features but it also helps to 

portray the character, as shown in Figure 1.22 
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Fig. 1.22 Adjusting character’s appearance and Poses 

Practical Activity 1.1 – Demonstrate the user interface of ‘Storyboard That’ 

software. 

Procedure 

Step 1. Open ‘Storyboard That’ application using following website address. 

https://www.storyboardthat.com/ 

Step 2. Now login application by using your Google/Facebook/Microsoft or any 

other account as shown in Figure 1.23. 

 
Fig. 1.23 Storyboard That login account 

Step 1. After logging in account, User interface opens, as shown in Figure 1.24. 

 

Fig. 1.24 Storyboard That user interface 

Step 4. Here you can select assets such as scene, character, text shapes and many 

more from top of the menu, as shown in Figure 1.25. 

https://www.storyboardthat.com/
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Fig. 1.25 Different assets in Storyboard That 

Step 5. Select the desired scene and drag & drop into the storyboard panel, as 

shown in Figure 1.26. 

 

Fig. 1.26 Drag and drop the scene into storyboard panel 

Step 6. Dropping the scene into panel, its control appears, as shown in Figure 1.27. 

It is possible to rotate, crop and edit the scene by using these controls. 

 

Fig. 1.27 Scene Control 

Step 7. Once the scene is setup, bring character into the scene, as shown in Figure 

1.28. 

 

Fig. 1.28 Character Control 

Step 8. By using control option, it is possible to change the colors of character as 

shown in Figure. 1.29 
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Fig. 1.29 Character color option 

Step 9. It is possible to ‘Edit the pose’ of the character, according to the scene 

requirement. Here you can choose face expression, arm and legs movement and 

different poses, as shown in Figure 1.30. 

 

Fig. 1.30 Pose option 

Step 10. Once this panel is completed, it is possible to move to different panel, as 

shown in Figure 1.31. 

 

Fig. 1.31 Storyboard Panels 

Step 11. Once all the panels created, click on ‘Save’ button to save the project, as 

shown in Figure 1.32. 

 
Fig. 1.32 Storyboard Panels 

Step 12. After saving the project, download it as shown in Figure 1.33. 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

49 

 
Fig. 1.33 Download Storyboard 

 

Assignment 2 

Explore Any 5 Freely available Storyboarding Software online and note down there 

Features and storyboarding methods. 

Summary 

• Digital storyboarding requires a digital tablet and digital pen. 

• Storyboarder is open source software. 

• Storyboarder has six simple drawing tools that are light and hard pencil, pen, 

brush, note pen and eraser. 

• In Storyboarder, board can be switched to adobe Photoshop for fine work. 

• Storyboard Pro is an industry standard storyboard software. 

• StoryboardThat is online storyboard software that provides range of 

backgrounds, characters and many more from their library. 

 

Check Your Progress 

A. Multiple Choice Questions 

1. The classic storyboard process is (a) hand drawn storyboarding (b) wall painting 

(c) storyboarding using computers (d) color painting 

2. For crating storyboard for animation in Photoshop, use thick line to avoid (a) line 

break (b) flicker (c) motion blur (d) jitter 

3. In Storyboard Pro, it is not possible to perform (a) drawing (b) 2D and 3D 

animation (c) stop motion (d) color correction 

4. The software that enables to create cartoon storyboard using range of assets is 

(a) Storyboard pro (b) Storyboard That (c) Photoshop (d) Shot Pro 

5. Storyboard That software have these poses (a) front, back, (b) right, left (c) a and 

b (d) top and side 

6. Storyboard artist use the hard pencil for (a) roughing (b) fine lines (c) tone (d) 

write notes 

B. Fill in the blanks 

1. The objective of storyboarding is to convey the action happening within the ____. 

2. In Adobe Photoshop software, it is possible to see only one ____ at a time. 

3. Storyboard Pro is one of the most powerful software which is particularly 

designed to create ________only. 

4. The variety of characters and their poses find in _______ software. 
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5. Storyboard That is a ________ software. 

6. Add ______ and _____ for a board on the right panel into Storyboarder. 

C. Select True or False 

1. Hand drawn storyboarding is a time saving process. 

2. Sound editing tools are not included in Storyboard Pro software. 

3. Storyboard Pro has the Thumbnail view on the bottom. 

4. Storyboard That poses helps to portray the character. 

5. The default scene cannot be edited in Storyboard That. 

D. Short Answer Questions 

1. Write the advantage and disadvantage of Hand-drawn storyboard. 

2. Draw interface of Photoshop. 

3. What tools and features are included in Toon boom Storyboard Pro? 

4. Draw user interface of Storyboard Pro. 

5. Write the benefits of using Storyboard That for storyboarding. 

6. What is Storyboarder? How it is different from other storyboarding software. 

7.  

Session 2: Digital Storyboarding in Story boarder 

Rama wants to become Digital storyboard artist. She has good sketching skill on paper, 

although she is learning to work digital tools such as computer, digital pad and pen. 

But the problem is what software she should use initially. There are many types of 

software and most of them are very costly. So here, Rama can begin her journey with 

open source software ‘Story boarder’. (Figure 2.1)   

 

Fig. 2.1 Rama is searching Storyboard software on internet 

In this chapter you will understand Storyboarder software and its system requirement 

and able to create storyboard using this software. 

2.1 Storyboarder 

Storyboarder is open-source storyboard software created by Wonder unit Inc. It is 

compatible with different operating systems such as Mac OS X, Windows, and Linux. It 

provides a digital platform to quickly visualize a story. It is possible to create animatic 

to present the story in video forms to other team members. 

In Storyboarder, the storyboard can be created by importing script. It is possible to 

create storyboard using different pen brushes. It provides all necessary tools for creating 

two dimensional arts. 3D modeling can also be performed, since it have great 3D engine 
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for creating basic models. Camera, objects, character, light can also be added and also 

import image into 3D shot generator. In Storyboarder, it is possible to write notes, add 

dialogues according to characters and write actions they are performing. Once the board 

is completed, it is possible to export this work in different format like pdf, animated gif 

and video. 

2.2 Hardware and Software Requirement 

Storyboarder 2.0 is available free for Windows 10, Linux and macOS under a modified 

MIT license. 

For experiencing manual sketching, choose one of the items from the following. 

1. Surface Pro 2017 

2. Surface Pro 4 

3. Wacom 13HD 

4. Wacom 13 HD Touch 

5. Wacom One Tablet 

6. Wacom Cintiq 22HD 

2.3 Getting Started with Storyboarder 

When you open Storyboarder software, it asks about some details like location, blank 

storyboard based on script and aspect ratio. The following activity will illustrate how to 

open the storyboard software. 

Practical Activity 2.1 Create a project on Storyboarder. 

Procedure 

Step 1. Double click on software desktop icon or search it on windows search bar 

(Fig.2.1(a) and (b)) 

 
Fig. 2.1(a) Software icon 

 
Fig. 2.1(b) Software icon 

Step 2. Clicking on software icon, opens welcome screen as shown in Figure 2.2. It 

gives information of recent storyboards. This screen also has three Tabs at the 

bottom; Getting started, Open, Create New Storyboard. 

 
Fig. 2.2 Welcome Screen of storyboarder 

The Getting Started tab links to a basic tutorial on the webpage and empower the 

knowledge of the software. It is question and answered by the wonder unit themselves. 

The Open Tab opens previous project, which is not on the recent list. 

To create a new project, click on the Create New Storyboard tab. 

Step 3. The window will open as shown in Figure 2.3. There are two ways to create a 
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new storyboard – Based on Script, and Blank Storyboard. 

 
Fig. 2.3 Create a new storyboard 

To import script or screenplay, it will support three formats – Story boarder, fountain, 

fdx. 

Now to create a blank storyboard, click on “Create a blank” button. It will open the 

window of Aspect Ratio. 

Step 2. Aspect Ratio determines the frame width over height. There are several aspect 

ratios available as shown in Figure 2.4. Keep in mind, film or video project aspect 

ratio, while choosing the correct one. You cannot change it further, once chosen. 

 
Fig. 2.4 Aspect Ratio 

Step 5. It will then ask to save the project. Save the project with the project name in 

desired location. Figure 2.5 shows the project saved with the name “The village”. 

 
Fig. 2.5 Project Folder 

 

Know More… 

A Storyboarder project folder contains two files- images and project files. In image 

folder you will get all the images of the boards in separate image file format. 

2.4 Story-boarder’s Interface 

Once the setup is completed, storyboard interface opens, as shown in Figure 2.6. 
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Fig. 2.6 Storyboarder User Interface 

Storyboarder interface is very simple and easy to learn. 

There are four main ways to design a board; 

1. Draw using pen tools. 

2. Link the board to Photoshop and the image made in Photoshop will be saved to 

the board. 

3. Import a photo as the board. 

4. Use the Shot Generator tool. 

2.2.1 Pen tools 

In Storyboarder interface, the top section has different types of pens and erasers as 

shown in Figure 2.7. It will help to directly draw into canvas using mouse or graphic 

drawing tablet. 

 

Fig. 2.7 Pen tools in Storyboarder 

It is possible to customize the size, color and opacity of these pens. In Pen tools, Light 

pencil is used for drawing rough idea. 

Fill brush tool is used to paint and fill. This brush is the steady stream of the ink. This 

tool draws on the fill layers. 

Tone pastel is used to tone and shades. This tool draws on the tones layers. 

Pencil is used to draw and shade details. It is lighter and softer than pen. 

Ink Marker is used for hard thicker line, suitable for fine inking and outlines. This tool 

draws on the ink layer. 

Brush is used to tone. 

Note Pen is used to write notes. 

Eraser is used to delete unwanted brush strokes or lines. 

Now let us discuss about some controls of Pen tools, which is useful to create 

something on boards. 

Brush Size controls the size of the brush, as shown in Figure 2.8 

Opacity control the transparency of the selected tool. 
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Fig. 2.8 Pen Controls 

Assignment 2.1 

Practice creating storyboard using Pen tools and list out the qualities of each pen 

that you observe. 

2.2.2 Tool section 

This section provides various controls on the board as shown in Figure 2.9. To get 

detail knowledge look at the Table 2.1. 

 

Fig. 2.9 Different tools in Storyboarder 

Table 2.1 Tool section 

Sl 

No. 

Tools Shortcut Action 

01 Bin tool Backspace Delete all the layers on the boards. Press Undo or 

(Ctrl+Z) to recover the accidentally deleted image. 

02 Move tool Ctrl Allows to move the image created to anywhere on 

the board. 

03 Scale tool Ctrl+ Alt Allows scaling the whole image on the board. 

04 Lasso tool L Allows highlighting a specific section of the board 

and moving it. 

05 Undo Ctrl+ Z Undo the actions 

06 Redo Ctrl+ 

Shift+ Z 

Redo the things just done. 

07 Grid guide  Adds an overlay of square grids to scene. 

08 Centre 

guide 

 Adds an overlay of a cross to show the center of 

the screen. 

09 Rule of 

Thirds guide 

 Add an overlay guide splitting the screen into 3 

equal sections. 

 

10 Onion skip 

guide 

O Adds an overlay from the previous board over the 

current one as a reference guide layer. 

11 Captions (C) Toggled on and off to show anything written in the 

dialogue section of the shot reference window of 

the board. 

12 Edit in 

Photoshop 

Ctrl+ Full 

stop 

Links the currently selected board to Photoshop 

for live editing. Saving the image on Photoshop 

will update on storyboard. Once linked you 

cannot edit the board in Storyboarder unless 

unlinked by double clicking on the board. 
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Assignment 2.2 

Use all the tools mentioned in tool section and understand working. 

2.2.3 Tools Short keys 

The short-keys of the tools provide freedom to work rapidly. Figure 2.10 shows the 

shortcut keys of different tools. 

 
Fig. 2.10 Shortcut keys 

2.5 Create Traditional board using Digital Pen 

Storyboarder software gives the liberty to draw and sketch traditional board digitally. 

Practical Activity 2.2 illustrates to create a traditional storyboard. 

Practical Activity 2.2. Create a traditional storyboard for following scene. 

Scene 01 

EXT. VILLAGE HOUSE COURTYARD- DAY 

Aarav (Male, age 5) is playing with ball in courtyard and his mother is making food. 

Procedure 

Step 1. Create a project on Storyboarder software, select appropriate location and 

open the project as shown in Figure 2.11. 

 
Fig. 2.11 Create new storyboard 

Step 2. Now software interface open, here use pen tool to create rough scene on the 

board as shown in Figure 2.12. 
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Fig. 2.12 Select the pen tool to draw the storyboard 

Step 3. Now storyboard is completed. Use Eraser to correct the image as shown in 

Figure 2.13. 

 
Fig. 2.13 Storyboard panel is created 

Step 2. If needed, multiple board can be added by clicking on + button as shown in 

Figure 2.14. 

 
Fig. 2.14 Add multiple panel 

Assignment 2.3 
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Create a storyboard for the given scene by using Storyboarder Pen tools. 

Scene 02 

INT. VILLAGE HOUSE ROOM – DAY 

Aarav is studying sitting on the floor. 

2.6 Adding boards and using the Shot Reference   

As you know, that storyboard is not created in single panel. It needs different panels for 

different shots. In Storyboarder software, it is possible to add multiple boards as per the 

requirement. Along with this some details of shots and scene can also be added with 

the panel.   

Adding boards – It is possible to add additional boards using the ‘New Board’ button 

at the bottom of the page or by pressing N on keyboard. Any number of boards can be 

added in sequence. It is shown in Figure 2.15. The new board added is shown in Figure 

2.16. 

 

Fig. 2.15 Press + button to adding boards              Fig. 2.16 New board added 

You can perform add, duplicate and more functions by Press and hold left mouse key 

to open board option as shown in Figure 2.17. 

 
Fig. 2.17 Open board options 

Write the details into Shot Reference – After drawing a shot on specific board panel, 

you need to add some details such as dialogues, action and duration of the shot or 

scene. This is called Shot Reference. The shot reference section is placed on the right 

side of the interface. It is possible to place all information about the current scene or 

shot shown on board.   

Duration – The duration of a specific shot can be changed during play back or exporting 

as a video or gif. Here you can fill the duration in milliseconds and frame rate. To keep 

your board for 2 second, fill 2000 on duration and 50 on FPS as shown in Figure 2.18. 

 
Fig. 2.18 Duration 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

58 

Dialogue – The dialogue is written here. When exported, it will display below the panel. 

However, if you keep active caption tool (C) in Tool section, the dialogue will be displayed 

inside the board as shown in Figure 2.19 (a) and (b). 

 

Fig. 2.19 (a) Dialogue                           Fig. 2.19 (b) Caption 

Actions – All the stage directions associated with the shot can be added in this section. 

These instructions will not appear in a video or GIF export, but when exporting as a 

PDF. 

Notes – Notes on the scene. 

2.7 Sound 

Audio features are present in shot reference section.   

Record button – It allows to record audio for the shot as shown in Figure 2.20. The 

audio will run separately to the shots, meaning that if a shot is five seconds long and 

the audio is eight second long then the last three seconds will run into the next shot or 

be cut off. 

 

Fig. 2.20 Record audio for the shot 

Select Audio File – allows adding in audio snippets, or back grounding sounds to the 

shots as shown in Figure 2.21. The audio will run separately to the shots, meaning that 

if a shot is five seconds long and the audio is eight second long then the last three 

seconds will run into the next shot or be cut off.   

 

Fig. 2.21 Select audio file 

Bin – Clears the audio file as shown in Figure 2.22. 

 

Fig. 2.22 Clear the audio file 

2.8 Adding image on the board 

Image can be added on the board panel. It supported only JPEG and PNG file. To import 

an image, click on File > Import images to New boards. 

So, let us import an image on board panel in Storyboarder software. 

Practical Activity 2.3 Add image into board panel in Storyboarder. 

Procedure 

Step 1. Open the already created project. The interface will open. It is also possible to 

create a new project. 

Step 2. To add image on the board; go to File > Import images to new boards. The 

short key for adding image is Ctrl+ Shift+ I. 
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Step 3. Now browse the image folder and click on open tab. Image is imported on the 

board as shown in Figure 2.23. 

 

Fig. 2.23 Image is imported on the board 

Step 2. To duplicate, image board; go to Boards > Duplicate Boards or press short 

key D.  Now another board is created with the same image. You can use it multiple 

times to show the background, as shown in Figure 2.24. 

 

Fig. 2.24 Created multiple boards 

Step 5. Draw the character or object as per the script over the background. 

2.9 The Shot Generator   

The shot generator is a powerful program built into Storyboarder that allows to create 

shots using 3D models, cameras, images, and more. 

To open shot generator, left click on shot generator icon as shown in Figure 2.25. Shot 

generator is located on the right side of the software interface. 

 

Fig. 2.25 Open Shot Generator 

The Shot generator window open, as shown in Figure 2.26. 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

60 

 

Fig. 2.26 Shot generator window 

In shot Generator, there are 6 elements – Camera, Object and Character, Light, Volume, 

Image 

Camera 

In any film or video production, camera is used to picturise the scene. Here a virtual 

camera can be added to the scene. This gives a reference to the cameraman about the 

focal length of the lens, camera placement and camera angle. Figure 2.27 shows the 

various functions of the camera. 

 
Fig. 2.27 Camera Window 

Table 2.2 Different camera controls 

Keyboard/Mouse Camera Control 

Use Scroll wheel on the mouse Change the focal length of the camera and it will 

appear zooming in and zoom out. 

W or Up key Move the camera toward object 

A or Down key Move the camera away from object 

S or Left key Move the camera left 

D or Right  key Move the camera right 

Holding the right mouse button and 

moving up or down 

Tilts the camera 

 

Holding the right mouse button and 

moving left or right 

Pans the camera in a circle around a fixed point 

Holding the left mouse button Spin the camera 360 degrees from its current 

location 

Holding down the scroll-wheel and 

move up and down with the mouse 

or use the R and F keys 

Elevates the camera 

If you have multiple cameras in a 

scene, then for switching between 

Use 1, 2, 3 numeric key 

Apart from these controls, a navigation panel can also be used to control the camera. It 

is located below the scene, as shown in Figure 2.28. 
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Fig. 2.28 Camera navigation panel 

Object 

Along the top all the items and objects can add to a scene. When an item is added in 

the scene, it will show up in the layer panel on the left-hand side, as shown in Figure 

2.29. 

 
Fig. 2.29 Select object 

The object can be adjusted by using object properties as shown in below. 

Table 2.3 Object properties 

Object Properties Function 

X Move the object left and right 

Y Bring the object Further and closer to the camera 

Z Bring the object up and down from the floor surface 

Width Increase/decrease width of the object 

Height Increase/decrease height of the object 

Depth Increase/decrease depth of the object 

Rotate X Rotate the object in X axis 

Rotate Y Rotate the object in Y axis 

Rotate Z Rotate the object in z axis 

Tint color Change the color of the object 

Drop object to the 

floor 

Bring the object on the floor if it is above or below the surface 

Now, let us create a scene using shot generator in Storyboarder. 

Practical Activity 2.2. Create a scene and add some object by using shot 

generator in Storyboarder software. 

Material required – Computer, Storyboarder software. 

Procedure 

Step 1. Open the Storyboarder software and create a project. A software interface 

opens. 

Step 2. Click on shot generator on the right side of interface, now a new window 

open. 

Step 3. In shot generator window, a camera is already added in the scene, as shown 
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in Figure 2.30. 

 

Fig. 2.30 Shot generator window 

Step 2. An object can be added into scene by clicking add object button. It is the 

default object as shown in Figure 2.31. 

 

Fig. 2.31 Add object in to the scene 

Step 5. To change the object as per requirement, click on the models tab in object 

properties panel, as shown in Figure 2.32. It is also possible to import 3D character 

into scene. 

 

Fig. 2.32 Different objects 

Step 6. Now the appropriate object is selected as shown in Figure 2.33. 
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Fig. 2.33 Object is selected 

Step 7. It is possible to adjust this 3D chair by using object properties as shown in 

Figure 2.34. Observe the change in object properties and adjustment in the object 

accordingly. 

 

Fig. 2.34 Adjust the chair 

Step 8. For adjusting the object, you can also use the purple navigation sphere, which 

is attached with the object. The final placement of the chair is shown in Figure 2.35. 

Also use camera control to get appropriate shot. 

 

Fig. 2.35 Purple navigation sphere 

Step 9. Now adjust the object by using object properties and navigation circle, as per 

the requirement as shown in Figure 2.36. 
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Fig. 2.36 Chair adjustment 

Character 

A character is a person, animal or other self-aware being in a story. Here we are talking 

about the character in film or animation. In Storyboarder, a 3D character can be added 

into scene by using shot generator. The poses of the character can also be changed by 

dragging control point spheres around. 

Practical Activity 2.5 – Add a character into scene. 

Procedure 

Step 1. Select Character option from the top of the shot generator window, as shown 

in Figure 2.37. 

 

Fig. 2.37 Select character option 

Step 2. As click on character, a 3D character appears into the scene, as shown in 

Figure 2.38. 

 

Fig. 2.38 3D character 

Step 3. Observe the character layer in scene panel as shown in Figure2.39. 

 

Fig. 2.39 Character layer 

Step 2. In character’s properties, it is possible to select the specific things such as 

hand, pose, models and emotions, as shown in Figure 2.40. 
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Fig. 2.40 Different poses 

Step 5. Here we need the character in sitting position on the chair. For this choose 

poses option as shown in Figure 2.41. 

 

Fig. 2.41 Select appropriate pose 

Step 6. Observe the character in sitting pose in the scene shown in Figure 2.42. 

 

Fig. 2.42 Character pose 

Step 7. Now click on the character in scene panel and adjust him either by using 

character properties (Figure 2.43) or control points in the scene (Figure 2.44). 

 

Fig. 2.43 Character property         Fig. 2.44 Control points 

Step 8. Now after using these properties and control point, the character is looking 

seated comfortably on the chair as shown in Figure 2.45. 
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Fig. 2.45 Correct pose of the character 

Step 9. You can also quickly set the shot size and camera angle by clicking on auto 

shot framing option as shown in Figure 2.46. 

 

Fig. 2.46 Setting shot size and camera angle 

Step 10. It is also possible to use open shot explorer in auto shot framing, as shown 

in Figure 2.47. 

 

Fig. 2.47 Auto shot framing 

Step 11. After completing the scene, insert it on the board. To insert it on current 

board, click on ‘save to board’ or for inserting it in a new board click on ‘Insert as 

new board’, as shown in Figure 2.48. 

 

Fig. 2.48 Insert the shot in board 

Step 12. Clicking on the ‘save to board’ the scene is inserted in current board, as 

shown in Figure 2.49. 
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Fig. 2.49 Insert the shot in current board 

Step 13. If shot change is required, click on the shot generator again and insert the 

shot by clicking ‘Insert as new board’. The Figure 2.50 shows the new shot in to the 

next board. 

 

Fig. 2.50 Shot is Inserted in new board 

Light – Light is used in film and video production to create an atmosphere according to 

the scene requirement. In shot generator, light can be used to understand its placement 

on actual scene as shown in Figure 2.51. Light properties can also be adjusted by using 

light properties panel. 

 

Fig. 2.51 Light’s placement 

Volume – In 3D scene, volume added some extra elements such as rain, fog or explosion. 

For example explosion is added in the scene as shown in Figure 2.52. These elements 

can be adjusted or changed by using volume’s properties window. 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

68 

 
Fig. 2.52 Explosion is added in to the scene 

Images 

Images can be added to the scene. To add an image, go to the properties section on the 

left and select the Image file tab. Then use the properties window to increase the image 

size, rotation and location. This is what you use to create floors, walls, and backgrounds 

of a set, as shown in Figure 2.53. With this feature, you can take a photo of the location 

for shoot and use it as a backdrop to the scene you are creating. 

 

Fig. 2.53 Image is added in to the scene 

2.10 Exporting 

There are a few export options available under File. 

Export as animated gif – is the default export setting and can quick export as a gif by 

pressing Ctrl/Cmd E on the keyboard. The gif sequence export will include any active 

caption and the duration of each shot.   

Export Scene for Final Cut Pro X and Premiere – exports the timeline as an .xml file 

creating a sequence including shots, duration, and audio used, and the captions used 

in your scene.   

Export Scene as Images – exports the whole timeline as individual images.   

Export Video – export the sequence as a video, and will include any caption have active, 

the duration of each shot, and any audio added to your scenes.   
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Export to Web – uploads the sequence onto the Storyboarder server. 

Export project as Zip – exports the entire project as a zip folder. This allows to open it 

on a new computer it remembers all the shot features and images of each board.   

Print and export to PDF – Exports the storyboard as a PDF. This is the other default 

export setting to quickly export as PDF with Ctrl/Cmd P.   

To export a section of a sequence, go to the boards mode and then shift and highlight 

all the boards you require, when you export it will only export this section. 

Summary 

• Storyboarder is free and open source software. 

• In Storyboarder, storyboard can be created using different pen brushes. 

• Decide aspect ratio of the project in the beginning, because it cannot be changed 

later. 

• Storyboard can be created on board panel in Storyboarder software. 

• Image and sound can also be added in Storyboarder software. 

• The Shot generator allows creating shot using 3D models, camera angles and 

images. 

• Storyboard can be exported in PDF format. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Storyboarder is a type of software (a) license based (b) open source (c) sole 

proprietorship (d) all of the above 

2. Storyboarder software is not compatible with operating system (a) Mac OS X (b) 

Windows (c) Linux (d) Symbian 

3. Which of the the following script format is not supported by Storyboarder (a) 

Fountain (b) fdx (c) docx (d) storyboarder 

4. A Storyboarder project folder contains (a) image files (b) project files (c) image and 

project files (d) video files 

5. Light pencil is used for drawing (a) fill layers (b) rough idea (c) tones and shades 

(d) hard thicker lines 

6. To highlight and move specific section of the board, choose (a) Bin tool (b) Lasso 

tool (c) Scale tool (d) Caption tool 

7. Short key to select light pencil tool (a) C (b) 1 (c) 2 (d) 3 

8. The Image format that can be imported in Storyboarder (a) JPEG (b) TIFF (c) BMP 

(d) PSD 

9. This element is not found in Shot Generator (a) camera (b) light (c) character (d) 

sound 

10. In character's properties you cannot select (a) hand (b) pose (c) models (d) clothes 

B. Fill in the blanks 

1. In Storyboarder, it is possible to import ______ and create storyboard according 

to it. 

2. Transparency of the pen tool is controlled by_______. 

3. In Storyboarder software, it is possible to add multiple _______. 

4. Dialogue, _______ and duration of the shot or scene can be added in shot 

reference. 
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5. Scene can be imported in_______ and premiere. 

6. In Shot Generator, use the ____ key to move the camera away from object. 

7. In film or video production_____ is used to create an atmosphere according to the 

scene requirement. 

C. Select whether True or False 

1. Aspect Ratio should be chosen before starting storyboarding. 

2. If you save the linked image on Photoshop it will update on storyboard. 

3. Shot generator allows Storyboarder to create shots using 2D models. 

4. In Storyboarder, storyboard is not exported in .pdf format. 

5. To elevate camera in shot generator, hold down the left mouse key. 

D. Short Answer Questions 

1. What are the main features of Storyboarder software? 

2. Draw a diagram of Storyboarder interface. 

3. Write different ways of design a board in Storyboarder software. 

4. Write the use of different pen tools used in Storyboarder. 

5. What is tool section? Why it is important? 

6. How to create 3D character in Storyboarder? 

7. Write about various export options available in Storyboarder. 

 

Session 3: Digital Storyboarding in Photoshop 

Storyboard is a graphical representation of a story and script. The storyboard is the 

most essential and initial part of any kind of film making. Creating a storyboard before 

starting the actual work helps to plan and understand the look and feel of work. It 

provides a kind of preview to actual idea and script in a less time. It is also possible to 

add images, transitions, voice and music to storyboard. In this chapter, you will 

understand to create storyboard using Adobe Photoshop software. 

3.1 Adobe Photoshop 

Photoshop is pixel/raster base Image Editing software as shown in Figure 3.1. Its 

Interface is divided into five segments. 

• Menu 

• Tool Box 

• Option Bar 

• Work Area Bar 

• Layers Panel 

 
Fig. 3.1 Photoshop interface 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

71 

More to Know…. 

Raster Image – Raster image is created by the pixel-based programs or captured with 

camera and scanner. 

Vector Image – Vector graphics are made up of paths with a mathematical formula 

(vector) that tells the path how it is shaped. It is shown in Figure 3.2. 

 
Fig. 3.2 Comparison of vector and raster image 

3.1.1 Menu 

The Menu bar is located on the top of the software. It has 11 elements: File, Edit, Image, 

Layer, Type, Select, Filter, 3D, View, Window and Help. As shown in Figure 3.3, user 

can access the sub-menu by clicking on the main menu. Menu bar used in different 

function like open and save file, select filter, hide or show any panel and many things. 

 

Fig. 3.3 Menu and submenu in Photoshop 

       

      Fig. 3.4 Photoshop  Compact   

Tool bar 

3.1.2 Tool Bar 

Tool bar of photoshop is divided mainly in four groups as shown in Figure 3.4. 

• Selection Tool 

• Retouching and Painting Tool 

• Drawing and Typing Tool 

• Navigation Tool 

• Crop Tool and measure tools also come in selection tools group.                            



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

72 

Table 3.1 Different group of Photoshop Tools 

Selection Tools 

Icon Tool and its 

keyboard shortcut 

Use 

 Move (V) Moves the layers and selections 

 Marquee (M) It’s a group of selection tool, which include rectangular, 

elliptical, single row and single column selections. 

 Lasso (L) It’s a freehand selection tool. It includes polygonal and 

magnetic selection tools. 

 Quick selection Tool 

(W) 

Selection based on color and textured similarity. 

Crop Tools 

 Crop (C) Crops the image. 

Measure Tools 

 Eyedropper (I) Samples colors from an Image 

Retouching and Painting Tools 

 
Spot Healing (J) Remove spots from photos 

 Brush (B) Create soft or hard strokes of color 

 
Clone Stamp (S) Paint with sample of the image 

 History Brush (Y) Restore part of an Image for earlier stage 

 Eraser (E) Erase pixels. 

 Gradient (G) Fill an area of an Image 

 Blur It Blurs Pixels. 

 Dodge (O) Lighten pixel of an image. It includes burn and sponge. 

Drawing and Typing Tools 

 Pen (P) Draw a vector path 

 Type Tool (T) Create a type layer 

 Path Selection (A) Manipulate a path 

 Custom Shape Tools (U) Provide different shapes option to draw 

Navigation Tools 

 Hand (H) Navigates the page 

 

 Zoom (Z) Magnify the image 

 

3.1.3 Option Bar 

It sets the option of the tools which you select in tools panel like if you select brush tool 

in tool bar then it’s option will be displayed below the menu bar. 

Brush Tool  
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Fig. 3.5 Option bar of brush tool 

Let’s use now learn about some Storyboarding specific tools. 

Table 3.2 Tools used in Storyboarding and their function 

Tool and its Functioning Image 

Move Tool  – It moves/ 

duplicates a selected image area 

or layer as shown in Figure 3.6. 

 
Fig. 3.6 Move Tool 

Eye dropper Tool – It selects 

color by taking samples from 

image as shown in Figure 3.7. 

 
Fig. 3.7 Eye dropper Tool 

Brush Tool – It is used for tracing 

the outline or draw a shape. Also 

useful for painting the object as 

shown in Figure 3.8. 

 
Fig. 3.8 Brush Tool 

Color Replacement Tool – It 

replaces color of image without 

changing image detail as shown 

in Figure 3.9. 

 
Fig. 3.9 Color 

Replacement Tool 

Paint bucket Tool – Fills the 

continuously colored area with 

the foreground color or pattern as 

shown in Figure 3.10. 

 
Fig. 3.10 Paint Bucket Tool 

Gradient Tool – It fills two colors 

gradually from one to another as 

shown in Figure 3.11.  
Fig. 3.11 Gradient Tool 
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Pen Tool – It creates straight 

lined and smooth curved vector 

shapes and paths as shown in 

Figure 3.12. 

 
Fig. 3.12 Pen Tool 

Hand Tool – It allows to navigate 

an edited image as shown in 

Figure 3.13. 

 
Fig. 3.13 Hand Tool 

3.1.4 Work area Bar 

Work area bar is a center stage where image editing is performed. 

3.1.5 Layer Panel 

Photoshop layer is like a sheet of stacked acetate. As shown in Figure 3.14 (a) Observe 

the transparent area of layer to the layer below. Move a layer to position the content of 

layer, as shown in Figure 3.14 (b). 

 
Fig. 3.14 (a) Multiple stacked acetate sheet 

 

Fig. 3.14 (b) Final Image 

Importing any object in Photoshop creates a single layer. Multiple layers can be added 

later for storyboarding, color correction, retouching. 
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Photoshop layer 

Photoshop layer is like transparent sheets where you can draw an image or paste the 

image cutout and finally see the result in single piece of image in different shade. Here 

this transparent slide is like a layer and visibility of below layer depends upon the 

transparency of above layers as shown in Figure 3.15. 

 

Fig. 3.15 Different Layers in Photoshop 

Video layer 

Video layers can be used to add video clip in Photoshop. After importing a video clip as 

a video layer mask, the layer, transform it, apply layer effects, paint on individual 

frames, or rasterize an individual frame and convert it to a standard layer. Use the 

Timeline panel to play the video within the image or to access individual frames, as 

shown in Figure 3.16. 

 

Fig. 3.16 Video Layer 

3.2 Storyboarding in Photoshop 

A storyboard is a composition of images through which user can create a storytelling of 

your script. It allows sketching or drawing a storyboard per frame in Photoshop 

software. On the other hand, it is useful to arrange already created images or drawings. 

For this, import these images or drawings to create your own storyboard. These drawn 

sketches frames or imported images need to be arranged in sequence order as per the 

script or story. 

Practical Activity 3.1, illustrate to create storyboard in Photoshop. 
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Practical Activity 3.1. Create a storyboard using Adobe Photoshop 

Procedure 

Step 1. Open the Photoshop software. First create a new Photoshop document for the 

storyboard. To create a new Photoshop document, go to ‘Menu Bar’. Now check on 

the File menu. It will expand with several of options. Select the ‘New’ from those 

opened options as shown in Figure 3.17. 

 

Fig. 3.17 Menu Bar in Photoshop 

After selecting the New option, a new window pop-up. 

OR 

Use keyboard shortcut to create a new document. The keyboard shortcut to create a 

new document is “Ctrl+ N”. New windows will pop-up on Photoshop screen by 

pressing “Ctrl+ N”. This window is titled with “New Document” and it has various 

properties like Name of document, Size (width and height) of storyboard, Resolution, 

Color Mode and few more as shown in Figure 3.18. 

 
Fig. 3.18 New document pop-up window 

In the Preset Details field, enter the name whatever is suitable to be assigned the 

storyboard. 

In the Width field, enter the value of storyboard width. 

In the Height field, enter the value of storyboard height. 

In the Resolution field, enter the value of storyboard resolution. Let’s set the value 

of Resolution to 72 for the best quality and clarity of the storyboard. The measuring 

unit for Resolution is “ppi”. This “ppi” is stands for “Pixels per inch”. 

In the color Mode field, select RGB from its drop-down menu list to create 

storyboard for digital platform. 

In the Background Content field, select White from its dropdown menu list. 

Click OK after filling all the required fields. 

Step 2. Click OK, Photoshop creates a new document for the storyboard as per the 

settings filled in that “New” window. Now white rectangular area, Art-board is available 

to create storyboard with required width and height, as shown in Figure 3.19. 
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Fig. 3.19 Art board 

As Photoshop created Art-board, a layer named Background has been created by 

default in the Layer Panel. To find this Layer Panel, go to Menu Bar, select the menu 

Windows. Go to Window menu, select the Layer option from its dropdown menu list, 

as shown in Figure 3.20. 

 

Fig. 3.20 Layer located inside Window menu 

A Layer Panel will be available at the right side of the user interface which contains 

a partially locked layer named Background. This layer is created by default, as shown 

in Figure 3.21. 

 

Fig. 3.21 Background layer inside Layer Panel 

Create or delete any selected layer while working on document. 

Step 3. Now to create a new layer, click on the option “Create a new layer” on the 

bottom of layer panel. It will create an empty transparent new layer right above the 

background layer with the default name “Layer 1”. Now start drawing the storyboard 

on this newly created Layer 1, as shown in Figure 3.22. 
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Fig. 3.22 Newly created “Layer 1” in Layer Panel 

Step 4. To start drawing, select Brush Tool from Toolbar. The Toolbar is located to 

the extreme left of the Interface of Photoshop. Go to Toolbar and Select Brush tool. OR 

Simply use keyboard shortcut to select Brush tool. The keyboard shortcut to select 

the Brush tool is “B”, as shown in Figure 3.23. 

 

Fig. 3.23 Brush tool inside Tool bar 

After selecting Brush tool, go to Property Bar located at very top of Photoshop Interface 

and Click Brush Preset to open brush preset option. It will pop-up in a floating window 

with the required brush settings, as shown in Figure 3.24. 

 

Fig. 3.24 Brush settings inside Brush Preset 

In this Brush preset window, you can do the following things, 

• Set the required size of brush inside the Size field. 

• Set the hardness of brush to 100% inside the Hardness field. This value of 100% 

hardness will give hard edges to brush. 

Step 3. Select the required color for brush to draw. To select the color, Go to Set 

Foreground color box and click on it. Set Foreground color is located inside Tool 

bar. As shown in Figure 3.25. 

 

Fig. 3.25 Set Foreground color 
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Click on Set Foreground color, to open a new window on the screen named Color 

Picker (Foreground color) shown in Figure 3.26. 

 

Fig. 3.26 Color Picker to set Foreground color 

From this color Picker window, select the color for drawing brush that is needed. 

Step 6. Now the brush is ready to start drawing storyboard. Using this brush tool, 

start drawing on the art-board. While drawing, make sure that Layer 1 is selected, as 

shown in Figure 3.27. Here we are actually working on the selected layer in layer 

panel. 

 

Fig. 3.27 Drawing storyboard with brush on art board 

Step 7. Now save this composition in Layer comp. To open layer comp, go to windows> 

layer comps. 

Step 8. In layer comp, click on new layer comp as shown in Figure 3.28. Now, the 

composition will be saved in new layer composition. 

 

Fig. 3.28 Layer comps 

Step 9. Further, create shot 02 and save the composition in Layer comp as shown in 

Figure 3.29. 
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Fig. 3.29 Create shot 02 

Step 10. By this way, further composition can be created, as shown in Figure 3.30. 

 

Fig. 3.30 Composition is created 

Step 11. Now For exporting the storyboard, Go to the layer> Export> Layer comps 

to file. Now a popup window appears, as shown in figure 3.31 Fill the details and 

click on ‘Run’. 

 

Fig. 3.31 Layer comps to file setting 

Step 12. Now observe that the storyboard panel in selected location as shown in 

Figure 3.32. 
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Fig. 3.32 Final storyboard 

3.3 Animatic 

It is a series of images played in sequence with a soundtrack. It is well known as 

animated storyboard. The main purpose of animatic is to define the timing for the 

moving image. When sound track is also added with this, it gives the feeling of finished 

video as shown in Figure 3.33. 

 

Fig. 3.33 Comparison of animatic with final animation 

Now, let us create an animatic from the above storyboard by using Adobe Photoshop 

software. 

Practical Activity 3.2 – Create an animatic of the above storyboard. 

Procedure 

To give animation to the drawing layers to get animatic of the storyboard, make sure 

that drawing layers are in correct sequence order inside the layer panel. 

Step 1. Go to Menu Bar, Select Window Menu. Select Timeline inside Window as 

shown in Figure 3.34. 

Step 2. Selecting Timeline Menu, a timeline will appear at bottom of Photoshop 

interface as shown in Figure 3.35. On this Timeline, create animatic from drawing and 

get animated storyboard. 

 
Fig. 3.34 Timeline window 

 
Fig. 3.35 Video timeline 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

82 

In the Timeline; Select the “Create Frame Animation” from the dropdown menu as 

shown in the Figure 3.36. 

 

Fig. 3.36 Select “Create Frame Animation” from dropdown menu in Timeline 

It will create a frame thumbnail on the timeline, as shown in the Figure 3.37. 

 
Fig. 3.37 Timeline and its options 

Step. 3 Now switch off all the layers from layer panel except the first layer, which can 

be the first drawing of the storyboard. Now only one layer switched on which is going 

to be first drawing of the storyboard, as shown in Figure 3.38. 

 

Fig. 3.38 Layers for frame animation 

Now go to the thumbnail in timeline and set the required Frame delay time (display 

time) to the current drawing from the dropdown menu as shown in Figure 3.39. 

 

Fig. 3.39 Timeline animation option 

Step 4. Duplicate the current frame by clicking on Duplicate selected frames. Select 
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the newly created duplicate frame. Now switch off the first drawing layer and switch 

ON the drawing layer which is to be seen as the second drawing of the storyboard. 

Make sure that only this second drawing layer should be switched ON and every other 

layer should be off in the layer panel of Photoshop. Again set the value for Frame 

delay time to this frame thumbnail. Now duplicate the current frame and this process 

to the rest of the layers and assign the desired delay time to each frame thumbnail. 

After finishing this, see the frame animation by clicking on the Plays animation 

button. It will play the animation on art-board screen. After finishing animation, select 

the desired looping option for the animation video. To do this, go to Select looping 

options and set the required option. 

Now storyboard animation has been completed. 

Step 3. Next is to export this storyboard animation. 

To export, go to File Menu in Menu bar, then go to Export and select Render Video, 

as shown in Figure 3.40. 

 

Fig. 3.40 Export your animation 

Step 6. After selecting the Render video Option, windows will pop-up for export 

setting. In this window, set the name and location for exporting storyboard output as 

shown in Figure 3.41. 

 

Fig. 3.41 Name and location for exporting the storyboard 

Select the output type for storyboard from the dropdown menu. Select the required 

fields of Format, Preset, Size and Frame rate. 
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After selecting the required settings click on Render. 

It will export the storyboard output to the location in the Render Video settings. 

Finally, enjoy the storyboard output. 

Summary 

• Adobe Photoshop is pixel/raster base Image Editing software. 

• In Photoshop, Brush tools are mostly used for creating storyboard. 

• Layer comp is used in Photoshop to save a single composition shot. 

• Timeline window is used to create animatic. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Adobe Photoshop is _________ (a) image editing software (b) 2D animation 

software (c) vector graphics software (d) video editing software 

2. In Adobe Photoshop, Tools box place on the ________ of software. (a) left (b) right 

(c) top (d) bottom 

3. Brush tool comes under which category? (a) selection tools (b) crop tools (c) 

retouching and painting tools (d) drawing and typing tools 

4. You can use _____ to add video clip in Photoshop. (a) video layer (b) image layer 

(c) vector layer (d) camera layer 

5. To create a new Photoshop document, you have to select (a) File > Open As (b) 

File > New (c) File > Import (d) Image > New 

6. As Photoshop created your Art-board, a layer name ___has been created by 

default in the layer panel (a) foreground (b) background (c) photoshop layer (d) 

bitmap layer 

7. The keyboard shortcut to select the Brush tool is (a) V (b) M (c) B (d) L 

8. Keyboard shortcut key to fill foreground color into selected area is (a) Alt+ 

Backspace (b) Ctrl+ Backspace (c) backspace (d) Ctrl+ Shift+ Delete 

9. In timeline window, you can perform (a) animation (b) image editing (c) color 

correction (d) image manipulation 

10. To export animatic, select (a) File> Export> Zoomify (b) File> Export> Render video 

(c) File> Save as (d) File> Print 

B. Fill in the blanks 

1. The tool, which fills two color gradually from one to another is called_________. 

2. To navigate within the art board, you have to select____ tool. 

3. You can sketch or draw ______ per frame in Photoshop software. 

4. In the Brush preset window, set hardness of your brush to ____ inside the 

hardness field. 

5. The shortcut key to create duplicate layer of current selected layer is____. 

6. To create a new document, press_____ in keyboard. 

7. In _______, you can set the required size of your brush. 

C. Select True or False 
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1. In Adobe Photoshop, Pen tool creates straight line and smooth curved raster 

shape and path. 

2. To start drawing you need to select Brush Tool from your Toolbar in Adobe 

Photoshop. 

3. From color Picker window, you can select the color for your drawing brush. 

4. Navigation tool is not included in Toolbar group. 

5. Photoshop layer is like transparent sheets. 

6. Set the value of Resolution to 100 PPI for the best quality and clarity of your 

storyboard. 

7. You can create a new layer or delete any selected layer anytime while working on 

your document. 

D. Short Answer Questions 

1. Explain Photoshop workspace. 

2. Write different groups of toolbars in Photoshop. 

3. Write the use of these tools (a)Move tool (b)Brush tool (c)Eraser tool (d)Pen tool 

4. What is layer panel in Photoshop? 

5. What is Art board? 

6. How can you select brush color in Photoshop? 

7. How animatic is created in Photoshop? 

8. What is the meaning of the term 'Render Video'? 

 
 

Session 4. Introduction to Toon Boom Storyboard Pro 
 

Toon Boom Storyboard Pro is a program that makes sketching simple into a digital 

medium. It is easily possible to create a fine quality output of a storyboard by using this 

software. Although, beginners find it little tough to start with, but things get easier as 

user continues to work on this regularly. 

In this chapter, you will understand the required basic technique to make a storyboard 

in Toon Boom Storyboard Pro. You will learn to plan and create storyboards as well as 

animatic using Toon Boom Storyboard Pro software as shown in Figure 4.1. 

 

Fig. 4.1 Toon Boom Storyboard Pro 

4.1 System Requirements for Toon Boom Storyboard Pro 
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Latest PC with Intel® Core™ i7 processor with minimum 8 GB RAM (recommended 16 

GB), Monitor 1920 x 1080 or higher, NVIDIA GeForce GTX 1060, NVIDIA GeForce GTX 

1070, Operating System Windows 10. 

4.2 Benefits of Toon Boom Storyboard Pro 

There are several benefits of using this software. It provides creative freedom, flexibility, 

functionality and sensitivity of tools. It allows to create highest quality storyboard. It is 

cost effective and time saving industry standard storyboarding software. It is specially 

built for animation professionals. 

4.3 Create a Project in Storyboard Pro 

After starting Toon Boom Storyboard Pro software, a welcome window appears with 

three options – Learning tools, What’s New, Join the community as shown in Figure 4.2. 

Click on each option for its detail. 

 

Fig. 4.2 Welcome screen 

To start the project, ignore it by clicking on Close button. Next, it will display a screen 

to start a new project, as shown in Figure 4.3. 

 

Fig. 4.3 Create a new project 

In the Project Name field, type the name to be given to the project. The name of project 

folder and the project file will be same. 

In the Project Directory field, click on the Browse button to give desired location path 

to the project on computer hard drive. 

In the Project Title field, type the name for project title. By default, this field will take 

the same name which is typed in Project Name field automatically, or change it if 

required. 

In the Project Subtitle field, type the subtitle for project. 
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In the Camera Size field, from drop down menu, choose any resolution size for the 

project, as shown in Figure 4.4. 

 

Fig. 4.4 Create Size 

In the Frame Rate field, set the value for frame rate. Set it to 24 for creating project for 

a film. 

In the Recent Projects field, user can find and open the projects on which they have 

recently worked on in the past. 

In the Open Project field, open any Storyboard Project by browsing inside the computer 

hard disk. 

In the Watch Video Tutorials field, watch the Toon Boom Storyboard Tutorials online. 

Click on Create Project button to get started with the new project. 

4.4 User interface of Toon Boom Storyboard Pro 

Clicked on the Create Project button, Toon Boom Storyboard Pro will get started with 

new project. The default work space or user Interface of Toon Boom Storyboard Pro will 

be displayed as shown in the Figure 4.5. 

 

Fig. 4.5 User Interface of Toon Boom Storyboard Pro 

4.4.1 Main Elements of User Interface 

Observe following elements in user interface. 

Top Menu – all the main menu of this software are available. 

Stage View – shows the preview of drawing. Draw and manage layers and opacity of the 

selected layer. Make any layers visible or hidden and lock or unlock any layer. 

Storyboard Toolbar – all the useful tools required for storyboarding project are present. 

Playback Toolbar – playback tools are present to watch storyboard. Play the animatic 

created here and observe it in the stage view if needed. 

Tools Toolbar – all the tools are available to create storyboard project. The small triangle 

indicates the additional tools inside the tool. 

Layer Toolbar – contains all the tools to work on layers such as to add vector layer, add 

bitmap layer, to remove any selected layer, to lock the selected layer and auto light table. 
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Panel View – contains all the information about any selected scene and panel like the 

number of scene and panel on which uses currently working on. Here customizes the 

duration of selected panel. You will find voice annotations, dialogue, action notes, 

slugging and notes options here for the project. 

Thumbnails View – contains all panels in the order sequence are available. Rearrange 

their scenes from here. If you select any particular panel, that panel’s drawing could be 

seen on stage view. we can only See the drawing here as a thumbnail but cannot draw 

anything on it. 

4.5 Workspace 

Workspace is the quick way to configure the user interface setting. It is based on specific 

work profile. There are six types of workspaces as shown in Figure 4.6. 

3D view – used to integrate 3D elements. 

Drawing – enables to draw the storyboard efficiently. 

Horizontal – It displays the classical horizontal paper storyboard layout. 

Overview – provide an organized overview of the project. The main space is in thumbnail 

view. 

PDF Review – displays the project with the views required to quickly set up PDF export. 

Pitch mode – maximizes the viewing space to focus solely on the story being pitched. 

Timeline – design to create animatic. 

Vertical – display the project as a classic vertical paper storyboard layout. 

 

Fig. 4.6 Workspace 

4.6 Drawing Tools 

Storyboard pro has two main drawing tools brush tools and pencil tools. Here you may 

prefer to work with vector layer or bitmap layer. On bitmap layers, you can only draw 

using solid or textured bitmap brushes. Hence, while vector layers are more flexible 

because they allow to easily manipulate and tweak parts of artwork. They can also 

accommodate more art styles. Figure 4.7 shows the comparison of vector and textured 

brush stroke. 

 

Fig. 4.7 Comparison of vector and textured brush stroke 
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4.7 Panels 

To build and organize storyboard project, use panels, scenes, sequences, and acts as 

shown in Figure 4.8. There are many options to customize these project elements to 

keep things clear and organized. 

 

Fig. 4.8 Panel, scene and sequence 

Panel/Shot – Panel is useful in representing an action through drawing. It is the white 

rectangle which represents the camera view. It is highlighted with red colored border in 

the thumbnails view. 

Scene – A scene can be described as a combination of multiple panels or a single panel. 

While storyboarding whenever the camera angle changes, it is required to create a new 

scene. In Toon Boom Storyboard Pro the scene is highlighted with gray colored box 

which includes panels. 

Sequence – It can be described as a combination of scenes in storyboard. These scenes 

are grouped together. Generally while shooting a film at one location, all the scenes shot 

on that particular location grouped in a sequence. Whenever the location changes for 

shoot the scenes will be grouped in a new sequence. 

Practical Activity 4.1 – Adding a view to workspace 

Step 1. Select any view from workspace, it will highlight with red border on the top 

right corner. Plus (+) button is available. 

For example, when we select the stage view we will find this + button on the top right 

corner of this stage view as shown in Figure 4.9. 

 

Fig. 4.9 Adding a view with + button 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

90 

Step 2. Click on it to expand the list as shown in Figure 4.10. 

 

Fig. 4.10 View list 

Step 3. Select the view to add it from this list. 

The selected view will appear as a new tab to that particular workspace view. 

Or 

Go to Window in the Menu bar and select any view required from the list. 

 

Practical Activity 4.2 – Dock any selected view to workspace. 

Step 1. Place a view by clicking and dragging, it through its tab to any set of tab of 

other workspace, as shown in Figure 4.11. 

 

Fig. 4.11 Placing a view in any other workspace 

Step 2. Make it as a floating single window if needed, as shown in Figure 4.12. 
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Fig. 4.12 A floating window tab of a view 

4.7 Layer Panel 

The Layer Panel is located to the right side of Stage view. It can be used to delete 

selected layer or add a new layer, group reorder, show, hide, lock or unlock any layer, 

as shown in Figure 4.13. A user can also enable or disable animation of any particular 

layer, can manage the opacity of any layer. It is also possible to show/hide whole panel 

from here. 

 

Fig. 4.13 Layer Panel 

4.8 Thumbnail view 

This panel is placed on the bottom side of software, where one can see all the panels of 

storyboard. The thumbnail view is arranged in chronological order from left to right. 

From this thumbnail view one can navigate through the storyboard and rearrange the 

order of panels and scenes of the storyboard. As shown in Figure 4.14. 

 

Fig. 4.14 Thumbnail view 
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4.9 Timeline view 

The Timeline view includes the thumbnail view too. Actually, timeline view is used to 

create animation of the sketch which is drawn for the storyboard. Also, it is useful to 

make animatic of storyboard in the form of video. It enables the user to give time 

duration to the panel to create animatic, as show in Figure 4.15. 

 

Fig. 4.15 Timeline view 

4.10 How to add or create scenes and panels 

A storyboard project includes scenes and panels. The artist can draw on these panels 

according to the script. All the panels and scenes are arranged in thumbnail view from 

left to right in chronological order. 

As discussed earlier, an animatic storyboard project needs panels, and a scene can be 

created with multiple composite panels. It means a scene consists of multiple numbers 

of panels. If the film is going to be shot in single location, each panel can be combined 

in a single scene. As the location of shooting changes, there may be a requirement to 

create different background layout as per the script and hence a new scene should be 

created. 

4.10.1 Creating new scene 

A scene may contain a single panel or multiple numbers of panels inside. That’s why 

while creating a new project; a scene is created by default having one panel inside it. 

Whenever user wants to create a new scene manually a panel is created inside it 

automatically, as shown in Figure 4.14. 

 

Fig. 4.16 Panel created inside a scene in thumbnail view by default 

Practical Activity 4.3. Add a new panel inside a scene to the storyboard. 

Step 1. Select the scene to create a panel inside and click on ‘new panel’ button in 

the storyboard toolbar, as shown in Figure 4.17. 

 

Fig. 4.17 Click on ‘New Panel’ button 
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OR 

Step 2. Right click on the panel and select new panel, as shown in Figure 4.18. 

 

Fig. 4.18 Right click on panel and select ‘new panel’ 

Practical Activity 4.4. Duplicate the selected panel. 

Step 1. Select the panel which needs to be duplicated. 

Step 2. Click on Duplicate selected panel button in the storyboard toolbar, as shown 

in Figure 4.19. 

 

Fig. 4.19 Click on ‘Duplicate selected panel’ 

OR Right click on the panel and select duplicate panel as shown in Figure 4.20. 

 

Fig. 4.20 Right click on the panel and select duplicate panel 

 

Practical Activity 4.5. Add a new scene to the storyboard. 

Step 1. Select any panel of the last scene of storyboard and click on New Scene button 

in the storyboard toolbar, as shown in Figure 4.21. 
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Fig. 4.21 Click on ‘New Scene’ button 

OR Right click on the panel and select new scene, as shown in Figure 4.22. 

 

Fig. 4.22 Create new scene 

Summary 

• Toon boom Storyboard pro is professional industry standard storyboarding 

software. 

• For drawing purpose, a vector or bitmap layer can be selected in storyboard pro 

software. 

• In Toon boom Storyboard pro, panel is used to represent action through drawing. 

• Scene is the combination of multiple panels. 

• Sequence is the combination of scenes. 

• In thumbnail new, all the panels can be viewed. 

• Timeline view is used to create animatic. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Storyboard Pro software is created by (a) Disney (b) Toom boom (c) Wonder unit 

(d) Frame forge 

2. Rectangle that represent camera view in storyboard pro is called (a) shot (b) scene 

(c) panel (d) sequence 

3. A sequence can be described as a combination of____ in our storyboard. (a) 

frames (b) shots (c) scenes (d) graphics 

4. Voice annotations, dialogue, action notes, slugging and notes options is found in 

(a) thumbnail view (b) panel view (c) stage view (d) playback 

5. The layer panel is located to the _____side of Stage view (a) left (b) right (c) top (d) 

bottom 

6. In thumbnail view, all the panels of your storyboards are arranged in (a) vertically 

(b) diagonally (c) horizontally (d) none of the above 

7. If the film is going to shoot in single location, you can combine each panel in (a) 

single shot (b) single scene (c) multiple scene (d) single sequence 

B. Fill in the blanks 

1. Toon boom Storyboard Pro provides flexibility, _______ and sensitivity of tools. 
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2. In the______ field, from drop down menu, you can choose any resolution size for 

your project. 

3. The ______ view shows the preview of drawing. 

4. Vector and ______ layer can be added from layer panel. 

5. Opacity of the layer can be changed in _____ panel. 

6. All the panels and scenes are arranged in _____ view. 

C. Select True or False 

1. Sequence can be described as a combination of multiple panels or a single panel. 

2. In the tool’s toolbar consists of all the useful tools needed for the storyboarding 

project. 

3. In the thumbnails view, you will find all your panels in the order sequence. 

4. In layer panel, you cannot create group of selected layers. 

5. Timeline view is used to create animation of your sketch which you draw for your 

storyboard. 

D. Short Answer Questions 

1. Write the system requirement for storyboard pro software. 

2. What is the benefit of using Storyboard Pro software? 

3. Explain Panel, Scene and Sequence. 

4. Explain user interface of Toon Boom storyboard Pro software. 

5. Write the main element of use interface. 

6. Write the uses of different views. 

7. Write the uses of layer panel. 

8. What is thumbnail and timeline view? 
 

Session 5. Digital Storyboarding in Storyboard Pro 

Storyboard Pro gives a little more flexibility when it comes to sketching ideas. So far, we 

have learned about the interface and various tools used in Storyboard Pro to create 

storyboards. In this chapter you will understand to create a storyboard project using 

Toon Boom Storyboard Pro software. 

5.1 Drawing and Layer Panel 

To start drawing the storyboard according to the script, a panel and brush is required. 

Select the panel in thumbnail view. 

Select the Brush tool from the Tools toolbar located at left hand side in the user 

interface as shown in Figure 5.1. 
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Fig. 5.1 Select Brush tool from Tools toolbar 

Select the layer named BG from Layer Panel. Here BG means background which could 

be used to draw any background drawings like location or place, as shown in Figure 

5.4. If the script demands to draw characters, use Layer A to draw characters on it, as 

shown in Figure 5.2. 

 

Fig. 5.2 Select layer for drawing 

Select Brush tool from the tool bar for the particular layer, then go to the stage view 

and start drawing on the white canvas area. Customize the settings of brush as per the 

requirements. 

To customize brush, select the brush tool, and go to Tools Properties located at right 

side of user interface. If you are not finding Tool Properties, then go to the “+” button of 

right panel and select Tool Properties from the list popped out. 

To customize the brush, go to Tool Properties panel. Select any brush from brush 

presets. Here, user can also manage the required brush size and brush smoothness 

from their respective sliders given in this tool property panel, as shown in Figure 5.3. 

 

Fig. 5.3 Customize the brush in Brush preset 

5.2 Adding a bitmap or Vector Layer 

For drawing storyboard, a layer is needed. Storyboard Pro provides two types of layers, 

Vector layer and Bitmap layer. 
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Select either bitmap layer or vector layer for drawing. By default, Storyboard provides 

two vector layers named as BG and A. But here let’s add a bitmap layer to start drawing 

for rough sketches, as shown in Figure 5.4. 

 

Fig. 5.4 Adding bitmap or vector layer 

Practical Activity 5.1. Drawing using Storyboard Pro software. 

Step 1. After adding a bitmap layer, select a drawing tool i.e., brush tool from left 

hand side of user interface (tools toolbar). Adjust its size from right hand side located 

tool properties (in brush properties). Also select the color from color palate located 

just below the brush properties, as shown in Figure 5.5. 

 

Fig. 5.5 Tools and tools properties 

Step 2. To select the required color manage the sliders of Hue, Saturation & Value 

OR select the color from swatches as shown in Figure 5.4. 

 

Fig. 5.6 Select the color for brush to draw 

Step 3. Now start drawing on canvas in stage view. Literally start with rough 

sketching for first panel of storyboard for first scene. Once rough sketching for 

current panel is ready. Create a new vector layer by clicking on the Add vector 

layer icon just like bitmap layer earlier was created. 
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Now, for the final work of rough sketches, start drawing over the top of rough 

sketches on the new created vector layer. But to draw this fair sketching, use Pencil 

tool. 

The Pencil tool is present just below the Brush tool in Tools toolbar as shown in 

Figure 5.7. 

Select the required pencil type and color. Adjust the size and smoothness of pencil 

from Pencil Properties (in Tool Properties) just like brush. 

It is possible to select any color, but the black color is recommended for best output 

of drawing. 

 

Fig. 5.7 Select Pencil tool 

Step 4. Use pencil tool to draw over the top of rough sketches on selected new vector 

layer. 

After finishing the current drawing, turn off rough sketch layer to get a clear view of 

fair drawing output. 

Remember all the drawings should be inside the camera view box otherwise the part 

of drawing falling outside the camera view box will be chopped out while exporting 

final output as shown in Figure 5.8. 

 

Fig. 5.8 Drawing in camera view 

Now, a fair, neat and clean vector layer drawing is ready on first panel of the 

storyboard. 

Step 5. To add shading and textures to the drawing, add a new bitmap layer under 

the current vector layer. 

Select the ‘brush tool’ from toolbar. Go to Tools properties under Brush properties. 
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Select the appropriate brush type and color. There are various types of brushes in 

‘Brush properties panels’ to select. Select any marker, watercolor or charcoal type of 

brush or any other brush. 

Start to add shades and texture to drawing with selected brush as shown in Figure 

5.9. 

 

Fig. 5.9 Adding shades and texture to drawing 

5.4 Adding Camera movements 

After adding shades and textures to the drawing, it is possible to apply camera 

animation to the current panel. Apply animation by Zooming in or zooming out the 

camera and apply motion to the camera. 

For example, add camera animation to the scene, if you want camera to go from wide 

angle shot to zoom in to close-up shot. Also, animate the camera to move vertically, 

horizontally or diagonally. It will add some life to storyboard and make impact. To apply 

such camera animation, 

1. Select the camera tool from left side located tools toolbar. 

2. Select the camera tool from toolbar, the camera transform in tool properties 

panel could be seen, as shown in Figure 5.10. 

 

Fig. 5.10 Camera tool and its properties 

3. To add camera movements, work with key frames in the timeline view to get 

different camera positions on different time. 

4. Select the timeline view. In the timeline view drawing panels, scenes and 

sequences could be seen. There will be a red line play-head on the timeline as 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

100 

shown in Figure 5.11, which is used to indicate the current frame time position. 

Move this red play-head left or right to move through the timeline. 

 

Fig. 5.11 Timeline 

 
Fig. 5.12 Camera and key frames properties 

Observe the Figure 5.12 to understand the useful properties of camera and key frames 

to add camera animation in storyboard. So, let us discuss some camera and key frames 

properties. 

Add key frame at the beginning of current panel – This button will add a key frame 

at the beginning of current selected panel. Find it in the timeline view. 

Add key frame at current panel – This button will add a key frame to the current frame 

of current panel. Find it in the timeline view. 

Add key frame at the end of current panel – This button will add a key frame at the 

end of current selected panel. Find it in the timeline view. 

Reset camera – This button will reset and delete all the key frames in the current 

selected scene. 

Reset selected key frames – This button will reset the selected camera key frames to 

default. 

Delete selected key frames – This button will delete the selected camera key frames. 

Let’s take an example to apply camera animation from a wide shot and zoom in to a 

close-up shot as shown in Figure 5.13. 

 
Fig. 5.13 Adding camera animation 

Practical Activity 5.2. Add a camera movement of long shot to zoom in to a close 
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up shot. 

Step 1. Select the camera tool, now the camera box in the camera view will highlight 

with a dark color border. Also, a small square will appear at top left corner of camera 

border and a small square will appear at bottom left of the camera border in camera 

view. 

To Zoom in or zoom out the camera with click and drag the small square appears on 

top left corner of camera border. Also, pan or move the camera with click and drag the 

small square appearing at bottom left corner of camera border. 

To Zoom in or zoom out the camera using focal length from camera transform in 

tool properties view. 

To pan or move camera using offset values from camera transform in tool properties 

view as shown in Figure 5.14. 

 

Fig. 5.14 Keyframes and camera properties 

Step 2. Go to the timeline view. 

To give camera movement right from start of the current panel, click on Add Key 

frame at the Beginning of Current Panel. It will add a key-frame at the beginning of 

the current selected panel. 

Click and drag the small square icon on top left corner of camera border in camera 

view to adjust the zoom value to set to your current selected panel at current frame. 

As for now, it is the beginning of selected panel. 

To pan or move the camera using the small square icon on bottom left corner of camera 

border in camera view. 

Step 3. After setting the desired parameters of camera zoom and pan, lock this. To 

lock the current setting of camera at current frame in panel, click on the button Add 

Keyframe at the Beginning of Current Panel. It will add a key-frame at the beginning 

of the current panel. 

Step 4. Now to zoom in the camera to the right-hand side character at the end of the 

current panel, click on the button Add Key frame at the End of Current Panel. It 

will add a key frame at the end of current panel. 

Step 5. Now go to the last frame of current panel. Click and drag the red play head to 

the last frame of panel. 

Zoom in the camera by Click and drag, the small square icon on top left corner of 

camera border in camera view to adjust the zoom value to set to current selected panel 

at current frame. As for now, it is the end of selected panel, as shown in Figure 5.15. 
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Fig. 5.15 Adding camera animation 

Step 4. Now first panel storyboard drawing is completed. To add a new panel for next 

drawing, click on the New Panel button, and repeat the same process for further 

drawing and camera animation. 

5.5 Adding Sound clip 

In Toon-boom storyboard pro, users can import sound clip for creating animatic. 

Practical Activity 5.3. Add a sound clip into timeline. 

Procedure 

Step 1. To import a sound clip, Go to timeline view. The audio track option is 

available below the panel thumbnails as shown in Figure 5.16. 

Step 2. Select the audio track in which the audio clip is to import. Right click at 

anywhere on the audio track area. Select the Import sound clips option as shown in 

Figure 5.16. 

 

Fig. 5.16 Importing sound clips 

A dialogue box will open to import sound clips as shown in Figure 5.17. 

 

Fig. 5.17 Importing sound clips dialogue box 

Step 3. Click on Browse button to open file browser. Find and select the required 
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sound file to import to storyboard project, and then click on open button. It will import 

the selected sound clip to selected audio track of current storyboard project. 

Step 4. To add more audio tracks, right click on audio track area and select New 

audio track option. A new audio track will add to project. 

5.6 Exporting storyboard project 

After completing the storyboard, the project can be exported into various files. 

1. Go to File menu, click on Export and select the desired export option from the 

available options. 

2. To export project to movie, select the movie option. A dialogue box will open as 

shown in Figure 5.18. 

 

Fig. 5.18 Exporting project into movie 

Click on the browse button. Select the location for saving the exported movie file and 

give the file a name. In the Export movie format option, open the drop-down menu, 

select the file format to save the project in. 

Summary 

• In Storyboard pro, it is possible to draw the character in separate layer. 

• Selection of bitmap or vector layer depends upon the drawing requirements. 

• In Storyboard pro, stage view is used for drawing purpose. 

• Drawing part outside the camera view box will not be exported in the final output. 

• Camera tools can be selected from the tools toolbar located at left side of interface. 

• A sound can also be imported in storyboard pro software for creating animatic. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. To start drawing a _____ is required for storyboarding (a) brush (b) layer (c) canvas 

(d) camera 

2. User can select the Brush tool located at (a) left hand side (b) right hand side (c) 

top side (d) bottom side 

3. Now after selecting Brush tool and the particular layer, go to the _____ view and 

start drawing (a) canvas (b) stage (c) thumbnail (d) camera 
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4. By default, storyboard provides two vector layers named as (a) B and A (b) BG 

and A (c) B and AB (d) BG and B 

5. The fair sketching can be drawn using (a) pencil tool (b) brush tool (c) paint tool 

(d) both a and b 

6. After adding shades and textures to drawing, user can (a) export (b) apply camera 

movements (c) delete background (d) add lighting 

7. If user wants to give camera movement right from start of current panel then they 

must click on (a) add key frame at the beginning of current panel (b) add key 

frame at current panel (c) add key frame at the end of current panel (d) reset 

selected key frame 

8. To import any sound clip, go to (a) thumbnail view (b) timeline view (c) panel view 

(d) stage view 

B. Fill in the blanks 

1. You can see a ___ which is a canvas to draw storyboard. 

2. In layers panel, BG means_________. 

3. To customize brush, select the brush tool, go to the_____ located at right hand 

side of user interface. 

4. Storyboard pro gives vector and ____ layer. 

5. To add ______and_______ to drawing, add a new bitmap layer underneath the 

current vector layer. 

6. Select the camera tool from left side located____ toolbar. 

7. It is possible to zoom in or zoom out the camera using focal length from _____ in 

tool properties view. 

8. The ____option is below the panel thumbnail. 

C. Select True or False 

1. Select the panel in thumbnail view to draw storyboard according to script. 

2. If script demands to draw characters, use Layer A to draw characters on it. 

3. The smoothness of the brush can be increased in tool properties panel. 

4. Color palate located just above the brush properties. 

5. To select the required color you need to manage the sliders of Levels. 

6. The part of drawing falling outside the camera view box will be chopped out from 

your exporting final output. 

7. To reach last frame of current panel, click and drag red lay head to the last frame. 

D. Short Answer Questions 

1. What is Drawing and Layer Panel in Storyboard Pro? 

2. How to select brush tools and its properties in Storyboard Pro? 

3. Write camera tool and its properties into Storyboard Pro? 

4. In Storyboard Pro, how to add key frames to create camera animation in 

storyboard? 

5. In Storyboard Pro, how to add sound clip in storyboard animation? 
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Session 6. Coloring Storyboard in Photoshop 

There are different views on coloring a storyboard. It is not necessarily needed to color 

every storyboard. Storyboard for TV animation may not require to color. The storyboard 

of feature animation may require to color for just adding ambiance to the shots or 

scenes. 

Many storyboard artists create storyboards just through drawings and apply only gray 

and black tones to these drawings. Light plays an important role in colors. There are 

different types of lighting techniques used to influence the overall ambiance of the 

scenario. Photoshop is used for importing the sketched output and coloring it layer by 

layer and providing it a gradient look at the end. 

6.1 Lighting and color 

There are three types of light to be mainly considered to color the storyboard. 

Key light – It is the primary light source, which shines directly on the center of the 

scene. It can shine directly on the subject, or for dramatic effects. It can be shifted in 

one direction. 

Fill light – It is used to reduce shadows created by key light. It is also called as reflective 

light. These are positioned opposite to key light. 

Backlight – It is placed behind the subject and is used to separate the artist appearance 

from the background. It creates a brilliant shine in hair and hence it is also called hair 

light. 

There is always shadow with light. Any object on which the rays of sunshine fall casts 

a shadow. The representation of shadow and light weight gives the 3D view to the 

subject and may strongly influence the atmosphere of a scene. Apart from shadows, 

light also creates reflections. There is no color without light. 

6.2 Coloring a storyboard 

To add colors to the storyboard, open a shot of storyboard in Photoshop and add colors 

to it. Consider a example of storyboard with drawings in black color on white paper. 

Consider a storyboard drawn on paper as shown in Figure 6.1. 

 

Fig. 6.1 Storyboard frame to be colored 

Practical Activity 6.1 – Color a frame of storyboard in Photoshop. 

Procedure 
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Step 1. First scan the figure and store in computer. Import the scanned copy of 

storyboard drawing to Photoshop. Initially, it opens with a background layer which 

is partially locked as shown in Figure 6.2. 

 

Fig. 6.2 Partially locked background layer in Layer Panel 

Step 2. Double-click on that Background layer, the New Layer window will pop-up 

as shown in Figure 6.3. Give the name of the layer as “Original Layer” in the Name 

field and press OK to unlock that partially locked layer. 

 

Fig. 6.3 Unlock the background layer 

Now we have a rasterized layer named “Original Layer” in the Layer Panel. 

Step 3. From menu bar select Layer > New Adjustment Layer > Levels. The window 

for levels setting will pop-up on the screen as shown in Figure 6.4. Alternately use the 

keyboard shortcut “Ctrl+ L” to select Levels. 

 

Fig. 6.4 Levels 

Use Levels to manage and balance the shadow, mid-tone and highlight tones of the 

storyboard frame. Levels have three input sliders to manage tones. With the help of 

these sliders it is possible to enhance the tone of the image for more clarity. The more 

contrast between background and drawing color will make it easy to select any 

particular part to delete or color as shown in Figure 6.5. 
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Fig. 6.5 Sliders inside Levels Window 

The sliders to manage the tonal quality of image are, 

Black point slider – To manage the shadow tone of image (darker tones). 

Mid-tone point slider – To manage the mid-tones of image (gray tones). 

White point slider – To manage the highlight tones of image (brighter tones). 

Now adjust the white and black tones of storyboard image with the help of these 

sliders. Make drawing outlines dark on the white background to easily separate them. 

Step 4. Select Magic Wand Tool from the Toolbar, as shown in Figure 6.6. 

Alternately use the keyboard shortcut “W” to select Magic Wand Tool. 

 

Fig. 6.6 Magic Wand Tool in Toolbar 

Step 5. Now click on the white part of image, a marquee selection will appear around 

the image. All the white pixels of image are now selected as shown in Figure 6.7. 

 

Fig. 6.7 Marquee Selection using Magic Wand Tool 

Step 4. Now, invert the current selection to select the black outlines of drawing. To 

invert the selection, go to Select in Menu Bar and click on Inverse Option. 
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Alternately, use the keyboard “Shift+Ctrl+I” shortcut to select the Inverse for inverse 

the selection as shown in Figure 6.6. 

 

Fig. 6.8 Invert the current selection 

Now, the drawing lines in the selection can be easily separated from the background 

as shown in Figure 6.9. 

 

Fig. 6.9 Marquee Selection of your drawing outlines only 

Step 7. Create a new layer and name it as “Storyboard 01”. 

Now hide this “Original” layer. 

Step 6. Go to layer “Storyboard 01” and select the Brush Tool from Toolbar, as shown 

in Figure 6.10. 

 

Fig. 6.10 Brush Tool 

Step 9. Set the required value of size and set hardness to 100% for selected brush as 

shown in Figure 6.11. 

 

Fig. 6.11 Brush Preset 

Step 10. From menu bar select Windows > Swatches. The Swatches window will pop-
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up on screen. Select black color in swatches library, as shown in Figure 6.12. 

 

Fig. 6.12 Swatches 

Step 11. Swipe the brush around the marquee selection of drawing completely. Make 

sure that the layer “Storyboard 01” is selected before using brush. It will create lines 

for drawing only on a separated layer, “Storyboard 01”. Now, black outlines of drawing 

is seen on distinct layer. 

Now, deselect the marquee selection using keyboard shortcut “Ctrl+ D”, OR go to 

Select > Deselect in Menu bar. 

Step 12. Go to Layer Panel and create a new layer as shown in Figure 6.13. 

 

Fig. 6.13 Create New Layer 

Name this layer as “My color”. Arrange this layer “My colors” below the drawing outline 

layer “Storyboard 01”. 

Step 13. Select the layer “My color”. Select a color to paint on the drawing from 

swatches library. 

Select the Brush Tool. Set its Size and Hardness from Brush Presets. 

Now, start painting on the drawing using brush. 

To get more controlling and editing smoothness, create a new layer every time 

whenever needed to paint with different color as shown in Figure 6.14. 

 

Fig. 6.14 Colored drawing with multiple different color 

It is better to use different layers to paint for different parts of the drawing. For 

example, paint with different colors on different layers for different parts like hair, 
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face, clothes and hands. 

Name each layer is in proper manner to manage the work. 

Step 14. To change any color that is been painted already, select the layer whose color 

is to be changed. 

Step 15. Go to Image > Adjustments > Hue/Saturation as shown in Figure 6.15. 

Alternatively use the keyboard shortcut key “Ctrl+ U”. 

 

Fig. 6.15 Hue/Saturation 

Step 14. To change current color, change value of Hue or move the Hue slider as 

shown in Figure 6.16. With every changing value of Hue get a different color. 

 

Fig. 6.16 Hue/Saturation window 

Step 12. Once coloring completed, save the file with appropriate name in the desired 

location by using the option File > Save as as shown in Figure 6.17. 

 

Fig. 6.17 Save as the frame 

Points to be considered when coloring storyboard 
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• Color fits into different categories and are something to stay within the back of 

head when storyboarding. 

• Use gestures to narrate the story, draw verbs (actions) rather than nouns (names 

of things). 

• Try a dozen alternative ways to compose a scene. The movie always says one 

thing at a time. 

• While storyboarding an action/battle scene, concentrate on shots that show 

where the action takes place. The action itself is going to be performed by the 

choreographers. Use blur to point action, motion, energy, and/or zoom. 

• Creatures and sets are designed by specialists, which means it needs a lot of 

practice to create one. 

• Make them distinguishable without drawing too many details. Eyes, mouth, and 

weight are essential and are enough to indicate emotions. 

• Body language alone can convey a mood or feeling without having many details. 

• Explore the chances of the characters – sketchy drawings are good. It depends 

on the number of poses within the drawing, the feeling, and, therefore, 

the importance of the shot. 

• If the character is within the foreground, add some tone/shadow to create his 

emotions clear. 

• Play with the opacity values to create depth—particles within the air cause more 

distant objects to seemingly disappear into the fog. 

 

CHECK YOUR PROGRESS 

A. Multiple choice questions 

1. Key light is the (a) primary light source (b) secondary light source (c) diffuse light 

source (d) flicker light source 

2. Fill light is used to reduce shadows created by (a) key light (b) back light (c) 

background light (d) diffuse light 

3. Whenever we import any image to Photoshop it opens with a (a) foreground layer 

(b) background layer (c) vector layer (d) 3D layer 

4. The keyboard shortcut to select the levels is (a) Ctrl+V (b) Ctrl+L (c) Ctrl+U (d) 

Ctrl+A 

5. Which slider level does not have (a) black point slider (b) mid-tone point slider (c) 

white point slider (d) grey point slider 

6. To change any color you have painted, select Image > Adjustment and then (a) 

levels (b) color balance (c) channel Mixer (d) hue/saturation 

B. Fill in the blanks 

1. Storyboard of a feature animation needs to be _____. 

2. Key light can use directly on the subject, or for dramatic effects, it can be shifted 

in ______. 

3. _________ can be used to separate the object from the background. 

4. Any object on which the rays of sunshine fall casts a _______. 
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5. The keyboard shortcut key to deselect the selection is _____. 

6. Use the keyboard shortcut ______ to inverse selection. 

C. Select True or False 

1. Fill light is placed opposite to back light. 

2. In levels control, White point slider manages the highlight tones. 

3. Always keep light sources in mind and not change them in the middle of a scene. 

4. The keyboard shortcut to select Magic Wand Tool is “W”. 

5. Play with the opacity values to create depth. 

6. Creatures and sets are designed by storyboard artist. 

D. Answer the Questions 

1. What is Key, Fill and Back light? 

2. Write the use of Levels in Photoshop? 

3. What is Magic Wand Tool? 

4. Explain Brush tool and its presets? 

5. How can you adjust the color, which you have painted over drawing? 

 

Module 3 Roles and Responsibilities 
of Storyboard Artist  

 

Module Overview 

 

A storyboard artist converts a script or even just an idea and turns it into a visual story. 

They are aware of how other people view the project. The storyboard is considered as a 

guide for all members of the assembly or production team. A storyboard is also a graphic 

design that tells the story by arranging pictures in a certain order. The boards should 

be as simple as possible. The use of storyboarding is not limited to filmmaking. Many 

times, they also need to draw the concept for a presentation or other specific reason. 

Storyboards are commonly used by filmmakers to bring their ideas from their 

imagination to the screen. Creating a dynamic storyboard requires expertise. 

There are many educational institutions, who are adapting storyboarding for betterment 

of studies. There is a great scope for storyboard artist in future. Some great examples 

of renowned film from various fields are discussed in this unit. 

 

Learning Outcomes 

After completing this module, you will be able to: 

• Explore various career paths and roles available in the field of storyboarding. 

• Understand how storyboarding techniques vary across different media, such as film, 

animation, and games. 

• Analyse real-world examples of storyboards to understand best practices and 

industry standards. 
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Module Structure 

Session 1: Career Opportunities 

Session 2: Storyboard for Different Media  

Session 1: Career Opportunities 

Nikita has completed professional course of graphic artist. Now she wants to make her 

career as a storyboard artist. (Figure 1.1 (a) & (b)) In this chapter you will understand 

about the work of storyboard artist. 

 
Fig. 1.1 (a) Storyboard artist 

 
Fig. 1.1 (b) Digital storyboard artist 

1.1 Work of storyboard artist 

Storyboard artists create scenes to describe the story. Their work is different from 

scriptwriters. The various inputs can be provided to scriptwriters by others but 

storyboard artist develop scenes at their own visualization to guide the others before 

actual shooting. Figure 1.2 shows a typical example of how storyboard panel is created. 

 

Fig. 1.2 Illustration of storyboard panel 

A storyboard artist has to draw or sketch the scene exactly as explained by director. 

Once storyboard is completed preview the scenes on computer or take a printout. Soft 

copy of storyboard is easy to share the point of view with other team members. 

The majority of a storyboard artists work consists of drawing with some text included. 

The storyboard has to be made in such a way that it clearly states what is going to 
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happen on the screen. It may include text to describe certain aspects in depth or to 

describe things from a technical point of view. 

In a single project a team of storyboard artists work together. They have to work in 

coordination to follow the same style for uniformity of the project. If a storyboard artist 

works on a game project they need to visualize the scenes. Sometimes they work on an 

element of the game or in character design as well. A storyboard artist is also responsible 

for the visual continuity of the story. 

Storyboard artists are responsible for “pitching” their boards to the director of film as 

shown in Figure 1.3. Pitching means to make the film clear by describing each 

storyboard panel to the director through the whole scenario. 

 

Fig. 1.3 Pitching the storyboard 

Assignment 1.1 

Select any 3 Hollywood animated feature films from – Lion King, Kung Fu Panda, 

Finding Nemo, Up, Moana, COCO, Spiderman. Find the storyboard artists of these 

movies and make a document of their work profile, storyboard styles, past work, 

awards, and achievements. 

1.2 Creating a portfolio 

A portfolio is the work profile of an artist to showcase their work to apply for the job in 

the entertainment industry. It is an advantage for the storyboard artist that they can 

prepare their portfolio in the form of storyboard as shown in Figure 1.4 this is the typical 

example of storyboard portfolio prepared by Toniko Pantoja. 

 

Fig. 1.4 Storyboard portfolio by storyboard artist Toniko Pantoja 
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An ideal portfolio for storyboard artist should be of 15-20 pages with 6-9 panels on each 

page. It is recommended to choose storyboard panels that reflects the potential of artist. 

For storyboard artist, it is important to draw the drawing from life such as coffee shop, 

airport, and traffic scene. 

1.3 Tips for good storyboard artist 

The sketching skills are important for storyboard artist, because a storyboard is used 

to visualize the scene and illustrate emotion and gestures of the character. It is 

necessary to work hard on drawing skills and visualization skills to stay competitive and 

progressive. The storyboard artist working in big company like Pixar or Disney said are 

continually improving their drawing skill. It is important to follow these tips to become 

a good storyboard artist. 

1. Memorize every moment and try to draw it on same today to improve the drawing 

skills. 

2. It is important to learn the technical perspective of cinematography like camera 

angle, camera movement, and transitions. The storyboard is also prepared for 

production of video games and animated films where virtual camera perspective is 

required. 

3. It is also important to learn some limitations and best practices in the industry. For 

example, the concept of 180-degree rule decides the position of the character within 

the scene. 

4. Cinema and photography is another important aspect to understand the details of 

creative production. 

5. It is always better to grab some experience in small studios or work in freelance 

project before approaching the big studio. 

1.4 Skills for storyboard artist 

The following are some of the essential skills to become good storyboard artist. 

Watch film and animation movies – keen observation of film, grammar and animation 

are important for storyboard artist. 

Language of the film – The knowledge of common film language such as acting, staging, 

shot composition, cutting, and transitions help the artist to prepare storyboard. 

Develop strong draftsmanship – For a good storyboard artist, it is essential to have a 

clear vision to communicate the story with the help of visuals. 

Keep command over details – A detail command on storyboard panels like gesture, 

emotion and expressions is required. 

Develop a team skill – Most of the time storyboard artists work in team. So, it is 

necessary to develop skill of working in team. 

1.5 Scope for Storyboard Artist 

A storyboard artist has an ample scope to work for preproduction in animation studios, 

film, television, advertising agencies, and game development. In addition to this they 

can work in graphic designing, education, healthcare, forensic, government sector, 

science and architecture. The following additional skills can wider the scope of 

storyboard artist. 

• Excellent communication skills 

• Proficiency in editing, drawing and graphics software 
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• Analysis capacity 

• Public speaking 

Summary 

• Storyboard artists are visual storyteller that creates scenes to describe story. 

• Drawing is an essential quality for storyboard artist. 

• A storyboard portfolio should be 15-20 pages long and each page should have 6-9 

panels. 

• For storyboard artist, it is important to draw the drawing from life such as coffee 

shop, airport, traffic scene. 

• Storyboard artist should follow the tips given in this chapter to become a good 

storyboard artist. 

• A storyboard artist can work in a variety of fields, including architecture, design, 

education, healthcare, forensics, and science. 

CHECK YOUR PROGRESS 

A. Multiple choice questions 

1. A storyboard artist (a) writes the script (b) create sets (c) transform the script into 

a visible story (d) writes screenplay 

2. Storyboard portfolio should be of (a) 1-5 pages (b) 5-10 pages (c) 10-15 pages (d) 

15-20 pages 

3. For storyboard artist, it is important to draw the (a) info graphics (b) line graphics 

(c) drawing from life (d) portrait drawing 

4. During scene setting, a virtual line drawn between the character is called as (a) 90 

degree rule (b) 180 degree rule (c) 1/3rd rule (d) golden rule 

5. Which is of the following knowledge is most important for storyboard artist (a) 

acting in the film (b) 3 D modeling (c) film and animation (d) texturing 

B. Fill in the blanks 

1. A storyboard artist is a visual ____. 

2. The work of storyboard artists is different from _______. 

3. Storyboard artist working in a game project need to _______ the scenes. 

4. A storyboard artist is responsible for the ______________ of the story. 

5. Technical perspective like camera angle, camera movement, and transitions comes 

under _________ 

6. Storyboard artist should have knowledge of acting, staging, ______, cutting, 

transition. 

C. Select True or False 

1. A storyboard artist has to draw or sketch the scene as explained by director. 

2. Storyboard should include text to describe things from a technical point of view. 

3. Storyboard artist need not to have a detail command on gesture, emotion and 

expressions. 

4. Knowledge of cinema and photography is important an important aspects for 

storyboard artist. 

5. A storyboard artist is not responsible for the visual continuity of the story. 

D. Short Answer Questions 

1. What are the important skills required by the storyboard artist? 

2. What is pitching. 
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3. What additional skills are required to wider the scope of storyboard artist. 

4. What are the points to be covered in the portfolio of storyboard artist. 

5. List out the essential skills required to become good storyboard artist. 
 

Session 2: Storyboard for Different Media 

Nisha went to shopping mall with her friends. There she saw some graphics panels on 

mobile shops which look like storyboard panels. She wondered to see how storyboards 

are used in advertising. (Figure 2.1) 

 

Fig. 2.1 Nisha is watching storyboard panel on shopping mall 

In this chapter you will understand about the various fields of storyboarding such as 

film, theater, comic books, architecture studio, presentation boards, novels, interactive 

media and software. You will also understand how sotryboards can be created in these 

area. 

2.1 Various Fields of Storyboarding 

Normally it is assumed that storyboarding is used as preproduction in film and 

animation. Apart from this there are many areas where storyboard is required to 

visualize the concept. It can be for business presentation or architectural design. Also 

in the education, storyboard is designed as pre-production for e-learning application. 

The following section will discuss the various application area of storyboards and its 

scope. 

2.1.1 Film 

It is important to note that a 8-minute cartoon sequence consists of over 70 drawings 

in an exceeding size of 10x15 cm. 

A film storyboard consists of series of frames, where different events of film are in 

sequence. It looks similar to comic books. 

Storyboard is very useful preproduction tool for directors and cinematographers. In 

producing TV advertisement, it is used to present the concept to the client. Storyboards 

are also helpful for calculating the cost of overall production, as shown in Figure 2.2. 
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Fig. 2.2 Comparison of storyboard with their movie ‘Batman; the dark knight’ 

Storyboard provides a visual layout of various scenes. It provides a vision about how 

the scene will look from camera point of view. Storyboard mostly includes technical 

details for film making. 

2.1.2 Theater 

Storyboards are used as a special tool in the theater to understand the layout of a scene. 

It is mostly used by drama directors and writers. A typical theater storyboard is shown 

in Figure 2.3. 

 

Fig. 2.3 Theatre storyboard 

2.1.3 Animatic 

Animatic means animated storyboard. Animatic is also useful for pre-visualizing the 

film before production starts. It is the first time when someone watching the movie in 

motion helps to get a sense of pacing, rhythm and progression. 

For making the animatic, it is required to cut the shots according to dialogue timing 

and pace of the film. The basic sound effects, dialogue recording and scratch sound 

track can be included into animatic. 

It is the last step to create animatic for 3D movie. Hence the story cannot be changed 

at this stage. Adobe After Effects is the most common software used for creating 

animatic. A typical animatic created is shown in Figure 2.4. 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

119 

 

Fig. 2.4 Animatics from the movie ‘Ironman 3’ 

2.1.4 Comic books 

The storyboard drawings are also used for comic books to describe the staging of people, 

backgrounds, and balloon placement with instructions to artist as needed with dialogue 

and subtitles as shown in Figure 2.5. 

 

Fig.2.5 ‘Chacha Chaudhary’ comic book 

2.1.5 Presentation Board 

It is used to plan advertising campaign such as commercial, advertising film and 

corporate video film. The presentation board has a higher quality as compared to the 

story board, because it needs to display expression, layout and mood. Now a days, most 

advertising agencies and marketing professionals are taking services of a storyboard 

artist. Marketing team tries to sell the product or service, using hand-drawn 

illustrations or actual photographs, as shown in Figure 2.6. 
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Fig. 2.6 Presentation board 

2.1.6 Architecture Studios 

Architectural studios also make use of storyboard to create a visualization presentation 

of the project. Now a days, it is possible to create a virtual model of building with the 

help of software such as 3D Max. Creating visual model is expensive and time taking 

process. So, it is always preferred to create a draft in the form of storyboard. Lather it 

can be used to define the sequence for animation using computer. Figure 2.7 shows the 

architecture storyboard. 

 

Fig. 2.7 Architecture board 

2.1.7 Novels 

The use of storyboards in novels is also becoming popular. Most of the authors compose 

their stories in scenes rather than chapters in text form. Storyboards are useful to 

organize the story in precise order and rearrange the scenes accordingly as shown in 

Figure 2.8. 
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Fig. 2.8 Example storyboard in Novel 

2.1.8 Interactive Media 

As storyboard is used in preproduction, it can be also used in preproduction of web 

development and instructional design. It describes the interactive events along with 

audio and motion in electronic form, as shown in Figure 2.9. 

 

Fig. 2.9 Interactive Media 

2.1.9 Software 

Storyboard can be used for preproduction in software development. The software work 

flow can be presented graphically by drawing the sequence of screens to clarify the 

working of software to clients. Thus storyboarding is useful during software engineering. 

It helps to understand the work flow of software. It is easy to modify the storyboard and 

less expensive as per the requirement in change in software. The storyboard approach 

provides an example for creating GUI programs for iOS and macOS as shown in Figure 

2.10. 
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Fig. 2.10 Mobile application storyboarding 

2.2 Benefit of Storyboarding in Various Media 

There are several advantages of using storyboard in various media. A storyboard allows 

the user in film or business to experiment with changes within the story to generate a 

more robust response or interest. For example, Flashbacks is the result of placing the 

storyboard in chronological order, to create suspense and interest in it. With the help of 

storyboard, the production team can plan the movie in advance. It helps to decide the 

style of camera shot, angle, and character position. The visual thinking and planning 

process allow to brainstorm and put up their ideas into storyboards. 

2.3 Tips to create storyboards 

Some of the tips are mentioned herewith to create a good storyboard.   

2.3.1 Keep it simple 

There are many free templates available with libraries of characters and stock 

backgrounds in Storyboard That software. Apart from these inbuilt characters and 

backgrounds, some more characters and backgrounds can be designed. 

Compare storyboard with any comic book. In comics, individual pages have multiple 

panels, where each panel capturing a visual movement within the story. Always follow 

the general rules. 

• Always use window area for drawing the action and below this window area, 

mention description or dialogue. 

• Initially, use the simplest tool pencil to create storyboard as shown in Figure 

2.11. With this it is possible to erase the mistakes and make the pictures sharp 

in each specific panel. 
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Fig. 2.11 Storyboard created by pencil 

•    The main focus of storyboard is to convey the information clarity. This can be 

achieved even the drawing skills are not good. Panels with stick figures are far better 

than beautiful pictures if they convey the information correctly as shown in Figure 

2.12. 

 

Fig.2.12 Stick figures 

2.3.2 Errors, Tips, and Tricks 

The most common mistakes are committed while creating storyboards are either the 

details are missing or they appear in excessive manner. These creates confusion. So it 

is essential to find a right balance between them. The best way to overcome this is to 

show the storyboard to the unknown persons. The storyboard artist may get necessary 

feedback to improve it further. 

Some further tips are required in the following areas. 

Cinema Terminologies 

Again, the goal is clarity, which means to ensure that audience follow the action and 

understand intent. Panning, tilting, tracking shots and zooming are the most important 

things to be included in storyboard because these factors can affect the the 

interpretation of the panel. Figure 2.13 shows the camera instruction in storyboard. 
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Fig. 2.13 Camera Instructions in storyboard 

Mention the Character’s direction 

The storyboard should guide about the character’s direction. The direction of the 

character is important in action sequences. If it is not clear, then it may create 

confusion. To fulfill this use the arrow which clearly indicates the direction of the 

characters. 

Include the location 

It is important to include at least some geography in each panel to attract the audience. 

Imagine a bank robbery sequence that goes from bank to street to the back of a car. It 

should indicate the location of character. Confirm the proper anchor point that could 

be as simple as an exit sign. 

2.5 Guideline for Storyboarding 

There are no such rules for storyboarding, but some guidelines and tips can help to 

develop skills in storyboarding. 

• Always try to add some details on scene and character. This will help the viewers 

to imagine the story. For example, add some utensil in kitchen scene or add some 

amusement thing like swing and children on park scene. 

• Experiment with camera angles, especially during the dramatic scenes. Try 

different shot sizes like over the shoulder shot and extreme close-up. 

• Avoid placing the character within the center of the panel, and try to utilize its 

negative space. 

• Avoid slanted bezels, awkward angles or screens divided in half with horizontal 

lines. 

• When sketching for crowd scene or stage scene, try to add multiple people instead 

of two or three people in background. 

• Ensure that the subject/character is looking within the correct direction of the 

camera. 

• Decide about the particular shot size or point of view to be used in specific scene. 

• Practice the sketching by observing you favorite movie. 

Summary 
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• Storyboarding is not only used in films but also in theatres, comic books, 

architecture studios, presentation boards, novels, interactive media, education 

and software fields. 

• In films, storyboard provides a visual layout of various scenes. 

• Animatic is used in film and animation to pre-visualize the final film. 

• Storyboard allows the users to experiment with changes in story to generate most 

robust response. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. A _______ cartoon sequence consists of over 70 drawings in an exceeding size of 

10x15 cm (a) 1 minute (b) 5 minute (c) 8 minute (d) 10 minute 

2. Animatic means (a) video film (b) animation (c) animated storyboard (d) stop 

motion animation 

3. The storyboard used to plan advertising is called (a) comic board (b) presentation 

board (c) theater storyboard (d) animatic 

4. In software development storyboard is used to (a) test the software (b) identify 

software specification (c) identify the problem (d) marketing purpose 

5. The current storyboard pattern was initially created by an animator from (a) Walt 

Disney studios (b) Pixar (c) Kodak (d) Fleischer studio 

6. The storyboard format was initially developed for (a) film (b) theater (c)  comics 

(d) animation 

7. Use of arrows or symbols to indicate (a) camera movements (b) camera position 

(c) character position (d) shot change 

B. Fill in the blanks 

1. Storyboards are also helpful for calculating the cost of _________. 

2. You can include basic sound effects, _____ and scratch sound track into animatic. 

3. Today, most advertising agencies and marketing professionals employ the 

services of a ______. 

4. The simplest way to draw a storyboard is to use a _____. 

5. When drawing multiple people or a stage, where a crowd is required, add _____ 

instead of just two people within the background. 

C. Select True or False 

1. A film storyboard or shooting board is basically a series of frames where we can 

sequence different events. 

2. Storyboards are not used in theaters. 

3. Presentation board has a higher quality than storyboard. 

4. Architectural studios also require storyboard artist to create a visualization 

presentation of the project.   

5. During software development, changing the storyboard is more expensive than 

changing the program. 
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6. Many professionals now use computer programs to form storyboards. 

7. Avoid placing your subject within the center of a panel and make the foremost of 

its negative space. 

D. Short Answer Questions 

1. What is the use of storyboarding in films? 

2. How can the storyboard be used in the theater? 

3. What is animatic? 

4. How storyboarding used as presentation boards? 

5. Explain the use of storyboarding is in interactive media?  

6. How is storyboard employed in software development? 

7. Explain the benefits of storyboarding in software development? 

8. How storyboarding can be used in education? 

 

Session 3. Storyboard Case Studies 

A storyboard can be in the form of a graphic design that sequences illustrations and 

photographs to nature a story. Most filmmakers use storyboards to present their 

concepts in the form of visuals. Creating a dynamic storyboard requires professional 

skills that can be achieved from storyboard examples. 

The well known professional storyboard examples were released by the DGA (Director’s 

guild of America). Some storyboard examples from the great movies are – Inception, 

Harry Potter, Gladiator, Star Wars, Jurassic Park are mainly categorized into following 

genre. 

Sci-Fi Movie – these movies are based on the impact of science incidents. 

Drama Movie – these movies are based on the life incidents that includes emotions 

conflicts and lots of drama. 

Horror Movie – these movies are based on unnatural or horror themes. 

Fantasy Movie – these movies are based on the myths and mythological and imaginary 

incidents. 

Web series – these are produced for daily entertainment of home based audience under 

OTT platform. 

Animation – these are the computer generated replica of real life incidents. 

Video Game – these are the computer generated replica of games. 

The typical storyboard of the above genre are given with description below. 

3.1 Genre : Sci-Fi 
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Movie - Star Wars – A New Hope 

Scene – A Galaxy Far, Far Away 

George Lucas created storyboard for the 

title sequence of Star Wars. Here C-3Po 

looks really different, compared to the 

film. Lucas knew how he wanted the 

final shot of firing the beam into the 

point as shown in Figure 3.1. 

 
Fig. 3.1 Storyboards from Star Wars a new 

hope 

Movie – Transformers 

Scene – The Blackout Rampage 

Observe the sketches of production 

design and scene of destruction from the 

artist point of view. It is interesting to 

create sketch of confused soldier as 

shown in Figure 3.2. 

 
Fig.3.2 Storyboards from Transformer movie 

by Ed Natividad 
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Movie – Inception 

Scene – Hallway Fight Scene 

Imagine a room that rotates and the 

character is stable in the middle of the 

room. The walls, props, fan, or window 

will help to stable the character. Observe 

the storyboard detailing in Figure 3.3, 

that the scene numbers on the left, added 

by the storyboard artists. 

 
Fig. 3.3 Storyboards by Gabriel Hardman for 

Christopher Nolan's 

3.2 Genre : Drama 

Movie Name – Gladiator 

Scene – Battle with Tiger. 

There is a clear chain of events in these 

storyboards. Intelligent camera 

placement leads depth and layers as 

shown in Figure 3.4. 

It is easier to create storyboard to 

visualize the incidence before 

proceeding for the actual shooting with 

tiger. 

 
Fig. 3.4 Gladiator storyboard 

Movie – Raiders of the Lost Ark 

Scene – The Opening of the Ark 

In this storyboard, the color shades 

play an important role to communicate 

the meaning of story as shown in 

Figure 3.5. The use of shading helps in 

lighting of the scene in this storyboard. 

 
Fig. 3.5 Storyboard by Ed Verreaux for Steven 

Spielberg's film. 
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Movie – Gone with the Wind 

Scene – Fleeing Atlanta 

Colors in the storyboard helps to create 

lighting themes in production stage. 

Figure 3.6 shows how written 

instructions describe the action. The 

last panel shows how to vary the size of 

slide. 

 
Fig. 3.6 Gone With the Wind done by William 

Menzies 

Movie – Apocalypse Now 

Scene – Ride of the Valkyries 

In this scene, the focus and the 

challenge is to shoot air cavalry. Figure 

3.7 shows the carnage behind Colonel 

Kilgore. 

This kind of Storyboards helps to 

visualize and plan shots when there is 

limited shooting time in a helicopter. 

 
Fig. 3.7 Storyboards by Alex Tavoularis for 

Francis Ford Coppola 

Movie – Ali 

Scene – Muhammad Ali vs. Ernie 

Terrell 

In Figure 3.8 storyboard, the panel 3 

shows the direction of arrow from 

punches. In panel 5, the wide 

establishing shot of arena replicate the 

set of actual fight. 

 
Fig. 3.8 Storyboards by Tim Burgard 

3.3 Horror Movies 
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Movie – Get Out 

Scene – Sunken Place Scene 

The storyboard in Figure 3.9 shows that 

Chris falls into a place that sinks down 

after being hypnotized. The panel 2, 3, 4 

shows the use of directional arrows. In 

panel 2 arrow shows the direction of the 

character, in panel 3 and 4 the 

directional arrows guide the camera. 

 
Fig. 3.9 The creator of the storyboard is 

Eric Yamamoto 

Movie – Psycho 

Scene – Trouble within the shower 

In this scene the knife shot is shown in 

sequence where the lady is taking bath 

and in the last scene the knife stabbed is 

shown in Figure 3.2. 

The happy face is seen on the first slide. 

Later it undergoes a significant tonal 

change during this scene. 

 
Fig. 3.10 Storyboard from the movie 

‘Psycho’ 

3.4 Fantasy Movies 

Movie – Spider-Man 2 

Scene – Train Battle 

This storyboard looks like a comic book. 

This is the battle fight scene between 

spider-man and Doctor Octopus. Spider-

man loses, and then wins. Figure 3.11 

shows how the directional arrows are 

used in this action scene. 

 

 
Fig. 3.11 Storyboards by Chris Buchinsky 

for Spider-Man 2 
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Movie – Logan 

Scene – Decapitation Scene 

This storyboard in Figure 3.12 shows the 

scene where Logan beheads Jackson. 

This can be a very detailed storyboard 

example from an awfully talented artist. 

There were many brutal scenes 

throughout Logan, and also a storyboard 

artist's job is to capture the emotion 

within the sketch, as shown in Figure 

3.12. 

 
Fig. 3.12 Logan Storyboard by Mark A. Vena 

Movie – Ant-Man 

Scene – Ant Rescue Scene 

The storyboard in Figure 3.13 shows that 

how the storyboard artist uses lines 

around the face to signal a shocked 

emotion from Scott Lang. 

This shows how essential storyboards are 

when combining live-action images with 

lighting tricks like in Ant-Man. 

 
Fig.3.13 Ant-Man Storyboard by Steven 

Markowski 

Movie – Harry Potter and the Order of 

the Phoenix 

Scene – Fight in the department of 

Mysteries 

The storyboard in Figure 3.14 shows the 

unusual angles in the fighting sequence. 

 

Fig. 3.14 Jim Cornish storyboards for 

Harry Potter 

3.5 Genre: Web Series 
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Web series – Game of Thrones 

Scene – Daenerys Targaryen Give Birth 

Scene 

The storyboard in Figure 3.15 shows the 

sequence of scene where Daenerys gives 

birth to three dragons. Observe the 

expression of her face from first to last 

panels in the storyboard. 

 
Fig. 3.15 Storyboard ‘Game of Throne’ 

Web series – Westworld 

Scene – Reckoning 

The storyboard in Figure 3.16 shows the 

parallel actions. Observe that the parallel 

actions are carried out in the single panel 

as shown in Figure 3.16. 

 

 

 
Fig. 3.16 Westworld Season 2: 

Storyboard created by Dan Caplan 

3.6 Genre: Animation Movies 

Movie – Kung Fu Panda 

Scene – Training Scene 

The storyboard in Figure 3.17 

shows the sequence of scenes 

where  Ponda tries to coach Kung 

Fu. In this animation storyboard, 

the photograph shown are the 

particular building blocks for the 

final film. Observe the proportion 

of colors used the scene. 

 

 
Fig. 3.17 Storyboard created by Angelo Libutti 
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Movie – Up 

Scene – Opening Scene 

The storyboard in Figure 3.18 

shows the starting scene in the 

film Up. This storyboard was made 

for an animated movie. Observe 

that how the storyboard is close to 

the final product.  
Fig. 3.18 Storyboard from UP movie 

Movie – Batman 

Scene – Series Intro 

The storyboard in Figure 3.19 

presents the intro scene for the 

Batman animated series. Observe 

the camera angles in this scene 

and how the directional arrows are 

used to shown the actions. 

 
Fig. 3.19 Storyboard of Batman movie 

3.7 Genre: Video Games 

Video game – Gears of War 

Scene – Mad World Trailer 

The example in Figure 3.20 depicts 

the trailer for Gears of War. The 

trailer also featured a song named 

"Mad World", which helps to 

successfully launch the series. Take 

a glance at the trailer to better 

understand how the storyboard is 

translated on screen. 
 

Fig. 3.20 Storyboard of Video game Gear of war’ 

Video game – Major League 

Baseball 

Scene – PS3 Move Trailer 

The example in Figure 3.21 is a 

storyboard that shows the trailer for 

big-league Baseball on Play station 

3. This storyboard was created to 

point out how play station movement 

system can mentally transport 

players on the sphere. 

 

 
Fig. 3.21 Storyboard of Video game ‘Big league 

baseball’ 
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3.8 Storyboards force creative filmmaking 

A storyboard is used by many professional filmmakers and production companies to 

clearly communicate their visual ideas among the other team members. Most of the 

amateur filmmakers overlook the idea of storyboarding, as they don’t have much budget 

for their film. Make sure to spend time in sketching and start working on ideas. If the 

drawing skills are not good, then ideas can be demonstrated using rough figures. 

Storyboard is a great source of inspiration, as they communicate the vision to team 

members. It is necessary to learn as much as possible from best storyboard examples. 

The ideas can be translated to storyboards of the leading project. 

Summary 

• Creating a dynamic storyboard requires skill, which could be learnt from 

storyboard examples to get some professional advice. 

• Storyboard helps to visualize dangerous scene like fighting with tiger, falling down 

the mountain. 

• Parallel action in a single storyboard can also be displayed. 

• Always try to create storyboard for your film. 

 

CHECK YOUR PROGRESS 

A. Multiple choice questions 

1. The last slide of storyboard by William for Gone with the Wind shows (a) a varied, 

vast screen canvas (b) how you can change your color (c) how you create a nice 

effect (d) how you can build a new storyboard 

2. The directional arrows shown in the storyboard Ali are (a) important but not for 

actual fight (b) not so important (c) important to replicate an actual fight (d) 

important for guiding the actor 

3. The storyboard of the movie Get Out shows a scene where Chris falls into the 

sunken place after being (a) hypnotized by Missy Armitage (b) wakeup (c) sleep 

(d) shocked 

4. In the storyboard the “Ant Rescue scene” belongs to the character (a) Logan (b) 

Tony stark (c) Scott Lang (d) Harry Potter 

5. In the storyboard “Harry Potter and The Order of the Phoenix”, which of the 

following shot helps to enter the department (a) Long shot (b) High angle shot (c) 

Low angle shot (d) Mid shot 

6. In the storyboard of Westworld, the arrows inform the (a) order of the edits (b) 

sequences (c) pattern of design (d) order of images 

7. In an animation storyboard of Kung Fu Panda, the images are the actual building 

blocks for the (a) middle image (b) first image (c) final image (d) second image 

B. Fill in the blanks 

1. George Lucas created a storyboard for the movie______. 

2. In the _______ storyboard, the blocking of the confused soldiers is interesting. 

3. The use of _________ helps in lighting of the scene in this storyboard. 

C. Select True or False 
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1. In storyboard of an animated series Batman, the directional arrows shows the 

direction of character’s action 

2. Major League Baseball storyboard was created to show how the PS move system 

could mentally transport players onto the real field. 

3. Storyboards are what filmmakers and companies use to clearly communicate 

ideas with their team. 

4. Storyboards are super beneficial not only for communicating the vision to others 

but also for analyzing your own decisions as well. 

5. Storyboards are super helpful for placing yourself in a creative place and helping 

you filter out good ideas and bad ones as well. 

D. Short Answer Questions 

1. Write the name of 5 Si-fi movies along with their storyboarding artists? 

2. List out 3 Drama Storyboard examples along with the scene? 

3. Share two horror movies name and their storyboarding scene? 

4. List out three prominent fantasy films known for storyboarding? 

5. Write down the scene description of any television series? 

6. What are the critical points you observe in animation storyboarding? 

 

 

Module 4  Occupational Health and Safety 

 

Module Overview 

 

The work culture in Animation and Gaming industry is different from routine office work. 

Storyboard artist work in close co-ordination with director, producer and other team 

members. Working with computer may create health problems in eyes. Adopting the safe 

work practice in the work place, can increase the productivity and help to reduce health 

related issues. 

In this unit you will know about the work environment required by storyboard artist 

including safety precaution to be observed during the work. It also explains general safety 

rules, probable work place hazard and how to deal with such hazards. In case of emer-

gency knowledge of evacuation process, fire exit and administrating first aid treatment 

is necessary. This is also explained in this unit. 

Learning Outcomes 

After completing this module, you will be able to: 

• Learn essential guidelines and practices to ensure a safe and productive working 

environment in storyboarding and related fields. 

Module Structure 

Session 1: Safe Working Practices 
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Session 1. Safe Working Practices 

Storyboarding is the preproduction work to be carried out mainly in the animation and 

gaming industry. A storyboard artist can either create a storyboard using hand drawn 

sketches on paper or use a digital tablet and pen. (Figure 1.1) A lot of concentration is 

required in drawing hence a good and peaceful working environment is required for this 

job. 

 

Fig. 1.1 Storyboard Artist 

In this chapter you will understand the work environment and resource required by 

storyboard artist. Health, safety and security at workplace and health related problems 

due to excess use of computer are also discussed. 

1.1 Work Environment for Storyboard artist 

The work environment for storyboard artist can be similar to Art or IT department. A 

storyboard artist work in a design studio or within art department of a production stu-

dio. S/he can work alone or in team of artiest. It also includes lot of planning and refer 

to various sources before proceeding for drawing. The drawing can be done manually 

on drawing board or in computer. They have to put extra hours and even work during 

weekend to complete the task within deadline. They generally work on contract basis 

probably on a temporary or freelance basis. 

1.2 Resources for Storyboard Artist 

A storyboard artist requires the following resources depending on the drawing. 

For hand drawn sketching work, the artist mainly requires – drawing pencils, 

sketchbook, quality drawing surfaces includes paper texture, paper weight, erasers 

such as rubber eraser, gum eraser, vinyl or plastic eraser, pencil sharpener, charcoal 

in stick and pencil form, drawing pens, ink, blending stumps. 

The tools required for digital storyboarding includes – Computer with, graphic tablet, 

digital pen and storyboard software. Computer requires proper electrical connections 

with earthing and internet connectivity. Projector or LED TV can provide the added 

advantage for displaying the final sketches. 

1.3 Introduction to health, safety and security at work place 

Every workplace accident, illness or dispute is a cost to organization, as well as a cost 

to injured individuals and their families. It is the responsibility of organisation to create 

a safe workplace. This helps to improve the workplace environment and the productivity. 

Employees have to take responsibility of their own health and safety rather than relying 

solely on the “safety officer” or management. 

1.3.1 Health 
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Health of an employee is the state of the physical, mental and social well being. Every 

organisation must provide healthy, clean and safe working environment for their 

employees. 

The work places must be cleaned in the morning before the people start working. If it is 

neat and clean then the people will feel happy to work. Proper air conditioning is 

essential to provide clean and cool air at workplace. Properly filtered water must be 

available for the employees. A cafeteria with fresh and good quality food helps to 

maintain the health of employee. The organisation should maintain clean wash-rooms 

for the use by employees. (Figure 1.2) 

 

Fig. 1.2 Healthy work environment 

1.3.2 Safety 

The work environment of the organisation must be safe. It must be free from hazards 

and risks. A hazard is the something that can cause harm to the people. A risk is a 

probability of causing harm to the people. Proper safety guidelines must be prepared by 

the company and followed strictly. At regular intervals of time, the safety procedures 

must be practiced by the employees. 

1.3.3 Security 

Every employee working in an organisation must feel that they are secured in the 

campus. Security is a kind of freedom from any potential harm. Security ensures the 

safety of the people working in the organisation as shown in Figure 1.3. Every 

organisation must have a separate department for security. This department is 

responsible for personal safety, computer system safety, electrical safety, transport 

safety and other equipment safety. The proper security procedures will reduce liabilities, 

insurance and compensation for an organisation. This will increase the business 

revenue and will reduce the operational charges of the company. 

 

Fig. 1.3 Security system 

1.4 General safety rules in the Studio 

• A storyboard artist should follow these safety rules while working alone or in the 

studio. 

Do not eat, drink, or smoke in the studios. 
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Substitute less hazardous materials or techniques when possible. There are many 

instances where highly toxic chemicals can be replaced by less toxic materials. 

Know the materials and their hazards. If labels do not provide adequate information 

regarding contents, hazards, and precautions, use resource books or the internet to 

search and know about the product. 

Store materials safely. Ensure to use clearly labeled unbreakable containers, and 

always cover them when not in use. Do not store materials in food containers to avoid 

accidental ingestion. 

Ensure proper ventilation. 

Wear appropriate personal protective equipment such as respirators, face shields, ear 

muffs, proper footwear and gloves. 

Ask if ever unsure about the operation of any equipment. Misuse of tool leads to 

accidents. So do not alter or modify any equipment without the recommendation of 

manufacturers. 

1.5 Workplace Safety Hazards 

The most common definition of hazard is ‘a danger or risk’ that is associated with 

something. Something can be considered a hazard even, if it would be a trigger for 

causing another hazard or could hurt someone or something in the area. Workplace 

hazards poses potential harm to people at work, and that can cause damage to the work 

environment and everything else in it. Hazards could cause adverse health effects and 

losses of property and equipment for organizations. 

There is a common way to classify hazards, and not all of these are present in all 

workplaces. In some industries like manufacturing and pharmaceuticals, there are 

biological and chemical risks that pose risks to the workers. Physical dangers are 

present as well in many industries where there is exposure to electricity, radiation, 

extreme pressures, noises and magnetic fields. On the other hand, ergonomic hazards 

are present in facilities where there are repetitive movements and where workstations 

are set up haphazardly. 

But it can be generalized that in all these classifications, there are always safety hazards 

that come up along with the highlighted workplace dangers. 

1.5.1 Physical hazards – It is the risk arising from the physical work environment – 

floors, facilities, walls, and ceilings. Physical hazards could also mean working with 

machinery and electricity-operated machines. Work processes or specific assignments 

could also qualify as areas where physical hazards are present. 

1.5.2 Electrical hazards – There are many reasons why workers get electrocuted or 

suffer from electric shock at work. For the most part, it is due to coming in direct contact 

with live wires, or having indirect contact through a conductor. While not all electrical 

accidents lead to death, there are many life-threatening, severe and often permanent 

injuries that could result from it. At work, the common causes of electrical accidents 

are exposed, worn-out wiring, overloading of electrical outlets, ungrounded or faulty 

equipment, and unsafe use of electrical equipment. Employees must be provided basic 

knowledge of using electrical equipment and common problems. Employees must also 

be provided instructions about electrical safety such as keeping water and food items 

away from electrical equipment. Electrical staff and engineers should carry out routine 

inspections of all wiring to make sure there are no damaged or broken wires. 
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1.5.3 Fire hazards – Each establishment must comply with housekeeping standards to 

ensure fire safety. Everyone does not fulfill such requirements, and this leads to 

accidents resulting to fire. Such events not only cause damage to vital workplace 

equipment, stock and other items, and the building; it could also lead to injuries among 

its employees. To avoid fire, it is very important to practice safety precautions. The whole 

organization must also have first response and emergency mitigation systems in place. 

Employees should be aware of all emergency exits, including fire escape routes, of the 

office building and also the locations of fire extinguishers and alarms. 

1.5.4 Health hazards – Health refers to the physical well-being of the employee, which 

includes the condition of their skin, eyes, ears and all other body parts. It also includes 

the health situation that cannot be seen upfront – their respiratory, cardiovascular, and 

nervous system. Hazards are present in most workplaces that could impact any part of 

the human body. For example, a noisy machine or factory environment could damage 

the sense of hearing. In the same manner, exposure to bright lights, toxic fumes and 

vapor could damage the eyes and nose. There are also more serious and long-term 

health issues arising from hazardous workplaces, such as damage to the lungs because 

of the exposure to harmful chemicals. 

1.5.5 Hazards using computers – Hazards while using computers include poor sitting 

postures or excessive duration of sitting in one position. These hazards may result in 

pain and strain. Making the same movement repetitively can also cause muscle fatigue. 

In addition, glare from the computer screen can be harmful to the eyes. Stretching at 

regular intervals or doing some simple yoga at seat itself can mitigate such hazards. 

Health related problems due to excess use of computer and its solution 

The excess use of computer can cause the various problems such as musculoskeletal 

problem, vision problem, repetitive stress injury and headache. The following precaution 

should be taken to avoid or reduce the problem. 

1. Musculoskeletal problems 

Neck and monitor position 

• Position the monitor to eye level such that the first line of text appearing on the 

monitor should be at your eye level. 

• Keep the neck with monitor. 

• Keep the monitor at least arm length distance, or 20 to 30 inch away as shown in 

Figure 1.4.  

 

Fig. 1.4 Ideal Neck and Monitor position 
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Body and chair positions 

• Maximize contact of back against the backrest of the chair. 

• Adjust the back of office chair 100-110 degree recline. A reclined angle reduces 

spinal pressure. 

• Keep the shoulders relaxed. 

• Adjust height of armrests so that elbows are at 100-110 degrees open angle. 

• Place keyboard at a slight negative tilt while sitting upright. 

• When typing, keep hands slightly lower than elbows with fingers pointing down-

wards to the floor. 

• Minimize any twisting of wrists from side to side or up and down. 

• Use a keyboard palm rest as needed only when you are not typing. Do not rest 

the wrists while typing, which lead to wrist strain. 

• Always take small breaks from computer work to stretch the muscles to keep the 

blood flowing, and to give rest to eyes. 

2. Vision Problems 

• Adjust the brightness of computer screen to save the eyes from strain. 

• Tilt the computer monitor to decrease glare. 

• Keep a proper vision distance from computer screen and blink eyes in interval. 

• Wear anti-glare glasses while working on computer. 

3. Repetitive Stress Injuries 

• Type gently to reduce stress from each fingers. 

• Keep the wrist flexible while typing. 

• Relax arms and get some stretches when you are not typing as shown in Figure 

1.5. 

 

Fig. 1.5 Keyboard and Mouse Position 

4. Headaches 

• Try your best to keep the neck straight in front of the computer and take 

breaks. 

Working environment – Potential hazards may include poor ventilation, chairs and 

tables of inappropriate height, hard furniture, poor lighting, staff that may be unaware 

of emergency procedures, or poor housekeeping. Hazards may also include physical or 

emotional intimidation, such as bullying or ganging up against someone. The staff 

should be made aware of organisation’s policies to fight against all the given hazards 

related to working environment. 
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1.6 Hazard Control 

Hazards that have been identified and assessed as priorities require implementation of 

adequate control measures. Control measures should follow the hierarchy with a strong 

emphasis on eliminating hazards at the source, whenever possible. 

• Take all feasible measures to eliminate the hazard, for example, by substituting 

or modifying the process. 

• If elimination is impractical or remains incomplete, take all feasible measures to 

isolate the hazard, for example, instituting engineering controls such as 

insulating noise. 

• If it is totally impossible to eliminate or isolate the hazard, minimize its likelihood 

to cause injury. Ensure that effective control measures are applied, such as 

installing proper exhaust ventilation and providing personal protective clothing 

and equipment that is properly used and maintained. 

1.7 Evacuation 

Every organization has evacuation procedure. Every organization has a safe place within 

the organization compound or outside the organization compound where all employees 

are expected to assemble in case of an emergency evacuation. The team leader guides 

the team and takes them to safe place. Emergencies which require immediate 

evacuation includes: 

• Explosions 

• Fires 

• Earthquakes 

• Hurricanes 

• Floods 

• Workplace violence 

• Toxic material releases 

• Tornadoes 

• Civil disturbances 

1.8 Fire Extinguisher 

A fire extinguisher is a protection device used to extinguish fires. A fire extinguisher is 

a cylindrical pressure vessel containing an agent which can be discharged to extinguish 

a fire. A fire extinguisher should always be available in areas where persons work with 

electrical equipment. Parts of fire extinguisher are shown in the Figure 1.6. 
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Fig. 1.6 Parts of fire extinguisher 

Practical activity 1.1 – Demonstrate the operation of a fire extinguisher in case of a 

fire emergency. 

Material required 

Fire extinguisher, burning emergency setup. 

Procedure 

Step 1. Identify the safety pin of fire extinguisher, which is generally present in its 

handle. 

Step 2. Break the seal and pull the safety pin from the handle. 

Step 3. Use the fire extinguisher by squeezing the lever. 

Step 4. Sweep it from side to side. It is shown in Figure 1.7. 

 

Fig. 1.7 Steps to open the seal and safety pin 

1.9 Health and Safety Signs 

Fire Equipment, it is shown in Figure 1.8 and 1.9. 
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Fig. 1.8 Fire Equipment Symbol 

Safe Condition 

 

Fig. 1.9 Safe condition Symbol 

1.10 Medical Emergency 

A medical emergency is a situation if a worker meets an accident and needs medical 

help. The medical injury may be severe or life threatening. Some of the situation may 

include a person is not breathing, heart attack or stock, heavy or severe bleeding, 

electric shock, in case of poisoning, person get burns on body. In case of medical 

emergency, the person or victim requires the immediate help. It is important to keep the 

contact number of emergency helpline or Emergency Medical Service (EMS) for the 

safety of workers as shown in Figure 1.10. 

 

Fig. 1.10 Different Medical Emergency 

Shock – The shock occurs in the human body on the failure of circulatory system. When 

insufficient amount of oxygen is reaching the body tissue, shocks occur. This condition 

is treated as soon as possible, if not it may lead to organ failure, which may cause death. 

Shock becomes worse by fear and pain of victim. 

First Aid for shock 

• If possible, keep the victims in lying down position. 

• Raise the legs 10-12 inches from the ground level only if no injury is suspected 

in back and bone. 

• If the victim starts vomiting then move the victim to the suitable place. 

• Loosen the tight clothing, as shown in Figure 1.11. 
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Fig. 1.11 Loosen the clothing 

If the victim is feeling cold then cover him. If the victim is feeling hot then don’t make 

suffocation by covering him, as shown in Figure 1.12. 

 

Fig. 1.12 Cover the victim if feeling cold 

1.11 First Aid 

In the workplace, there are many situations which require immediate first aid to the 

victim as shown in Figure 1.13. For this, the worker needs the special training and area 

for achieving the immediate first aid. The training of first aid does not need any type of 

specific tools and equipment but may involve the improvisation with material offered at 

the time of training. 

 

Fig. 1.13 First Aid pyramid 

While delivering First Aid always remember: 

• To prevent from degradation. 

• Act deliberately and confidently with the victim. 

• The timings of Golden Hour should be first 60 minutes from an accident. 

• The timings of Platinum Period should be first 15 minutes following an accident. 

• Prevent the body shock and choking. 

• Stop bleeding from the wound. 

• Loosen the clothes of victim. 

• Regulate the respiratory system of the victim. 

• Avoid crowding near the victim. 

• Take the victim to safe place or hospital near the workplace. 
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• Attend the emergencies situation with ease and without fear. 

• Always remember not to overdo, because the person providing first aid is not a 

doctor. 

1.13 First Aid Kit 

First aid is the assistance given to any person suffering a sudden illness or injury with 

care provided to same life, prevent the condition from worsening, or promote recovery, 

it is shown in Figure 1.14. 

 

Fig. 1.14 First Aid Kit 

Kits vary in contents but most kits have the following items: 

• Band-Aids / Adhesive bandages 

• Gauze pads and tape 

• Scissors, cold pack 

• Wound bandage / compress 

• Eye pads / eye wash solution 

• First aid / burn cream 

• Antibiotic ointment 

• Face shield or barrier mask for providing CPR 

• Forceps / tweezers 

• Disposable thermometers 

• First aid instruction booklet 

Summary 

• Physical hazards are the risk arising from the physical work environment such as 

floors, facilities, walls and ceilings. 

• Hazards using excessive use of computer might be musculoskeletal problem and 

vision related problem, repetitive stress injuries and headache. 

• Some of the evacuation conditions are explosion, fires, earthquakes, hurricanes, 

floods, violence at workplace and many more. 

• In Medical emergency, a worker meets an accident and needs medical helps. 

 

 

 



 

Storyboard Artist, Grade X 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

146 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. The work environment for storyboard artist is similar to (a) Art Department (b) IT 

Department (c) Pharmaceutical industry (d) Both (a) and (b) 

2. Which of the following is not required for hand drawn sketching (a) Sketchbook (b) 

Charcoal stick (c) Eraser (d) Graphic tablet 

3. In sitting position the back of office chair is to be adjusted (a) 100-110 degree re-

cline (b) 110-120 degree recline (c) 130 degree recline (d) 140 degree recline 

4. Emergency evacuation is needed when (a) there is a power-cut in the building (b) 

staying within the building is not safe (c) raining heavily outside (d) there is a thun-

derstorm outside 

5. A fire extinguisher is used to (a) spread fire (b) control fire (c) iron welding (d) melt 

wire 

6. A medical emergency is a situation in which (a) worker met on accident and needs 

medical help (b) accident occurs outside the premises (c) small injuries happen to 

the workers (d) worker feels minor headache 

7. Which of the following is not the first aid treatment for shock (a) keep the victims 

in lying down position (b) raise the legs 10-12 inches from the ground level (c) 

victim is feeling hot then don’t make suffocation by covering him (d) apply some 

kind of moist heat on the affected area 

8. The first aid pyramid does not include (a) preserve life (b) prevent further harm (c) 

promote Recovery (d) treatment the patient 

B. Fill in the blanks. 

1. Health of an employee is the state of the physical, mental and ________ well being. 

2. A hazard is something that can cause _______ to the people. 

3. Store materials safely and ensure to use _________ unbreakable containers. 

4. Hazards while using computers include ________ or excessive duration of sitting 

in one position. 

5. Monitor should be placed _______ inch away from you. 

6. A fire extinguisher is a protection device used to _______. 

7. The medical injury may be _________. 

8. In case of medical emergency, the person or victim requires the _________. 

9. First aid is the _________ given to any person suffering a sudden illness or injury. 

10. Take the victim to _________ near the workplace. 

C. State True and False 

1. Graphic tablet and digital pen is required for digital storyboarding work. 

2. A proper air conditioning is mandatory to provide clean and cool air at the work-

place. 

3. Electrical hazard is the risks arising from the physical work environment – floors, 

facilities, walls, and ceilings. 

4. Keep your wrist tight while typing on keyboard. 
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5. Every organization has a safe place within the organization compound or    outside 

the organization. 

6. Violence at workplace is also a kind of emergency situation. 

7. Safe condition symbol are indicated in blue color. 

8. If Person is not inhaling, then it is a situation of medical emergency. 

9. While delivering First Aid always avoid crowding near the victim. 

D. Short Answer Questions. 

1. What type of work environment is required for storyboard artist. 

2. Explain health, safety and security at workplace. 

3. What are workplace safety hazards? 

4. What are the potential sources of hazards in an organization? 

5. What is evacuation? Write the condition for evacuation. 

6. Explain fire evacuation plan with help of diagram. 

7. What is a medical emergency? 

8. Write some situations of medical emergency? 

9. When does shock occurs in human body? Write the first aid for shock? 

10. Draw a diagram of First aid pyramid? 

 

 

 

 

Glossary 

3D Modeling – Technique in computer graphics to produce a 3D digital representation 

of any object or surface. Three dimensional models are used for a variety of mediums 

including video games, movies, architecture, illustration, engineering, and commercial 

advertising. 

Additive color Model – In this color model red, green and blur are mixed together to 

create wide range of color. 

Animatic – Series of images or drawings played in a sequence with appropriate sound 

track. In essence, it’s an animated storyboard. 

Audience – Group of people who participate in a show or encounter a work of art, 

literature, theater, music, video games, or academics in any medium. 

Automation – A wide range of technologies that reduce the amount of time that 

humans are needed in processes. 

Character – A person represented in a film, play or story. 

Color –  When light strikes on an object, it reflects some rays that reflected part of rays 

is known as color. 

Color Presets – Saved color scheme to produce specific look. 

Color Scheme – Color combinations based on color wheel and utilized in a variety of 

design fields, including fine art, interior design, and graphic design. 
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Cool color – Violet, blue, light blue, cyan and sea green are considered cool color. 

Emotions associated with these colors range from calm and peace to sadness, 

withdrawal and repression. 

Contrast – The color from opposite segment from the color wheel. 

Customization – To modify or manufacture according to individual or personal 

specifications or preference. 

Depth – The clear distance from front to back or near too far in an artwork. Various 

perspective techniques are used to create the illusion of depth in paintings or drawings. 

Dissolve – Gradual transition from one image to the next, with the first image gradually 

fading while the second image emerges. 

Evacuation – Act of moving people from a dangerous place to somewhere safe. 

Fade In/Out – An optical effect, in which a shot appears gradually out of darkness and 

then gradually faded away. 

Flash-back – A part of film, play or story that shows something that happened before 

the main story. 

GUI – Graphic User interface; an interface through which a user interacts with 

electronic devices such as computers and smartphones through the use of icons, 

menus and other visual indicators. GUI representations are manipulated by a pointing 

device such as a mouse, trackball, stylus, or by a finger on a touch screen. 

HEX Code – Six-digit combination of letters and numbers that represent an RGB color. 

It is mainly used in web design. For instance, #69BE28 is HEX code for Green color. 

Hieroglyphics – An ancient Egyptian writing system in which a small picture represent 

a word or sound. 

Illustration – Drawing, painting, collage, engraving, photo that explains something. If 

your drawing is not explaining anything, it is a work of art, not an illustration. 

Info-graphic – Visual representation of any kind of information or data. 

Jump cut – When a single shot is broken by a cut that makes the subject appear to 

jump instantly forward in time. 

Metadata – Data that provides information about one or more aspect of data. 

Mid-tone – Middle tone of an image, in which the colors are in between. For example, 

if we select black And white then mid-tone will be gray. 

Mind Maps – Unique visual that allows a brain storming session to become a tangible 

and editable object. Mind maps combine layouts, colors, images, and font sizes to best 

illustrate the hierarchy of importance and train of thought of the creator, and always 

lead to the most effective brainstorming sessions. 

Pixar – Pixar Animation Studios, commonly known as Pixar. It is an American computer 

animation studio known for its critically and commercially successful computer 

animated feature films. It is based in Emeryville, California, and is a subsidiary of Walt 

Disney Studios owned by The Walt Disney Company. 

Pdf File – Portable document file; It is an universal file format developed by Adobe that 

preserves all the fonts, formatting, graphics, and color of any source document, 

regardless of the application and platform used to create it. 

RGB Code – The most commonly used color profile in the world of computers, TV 

screens and mobile devices. For example, RGB code for red is 255, 0,0. 

Reaction Shots – When an action on the screen is followed by a cut to a second shot 

that allows the viewer to see the reaction of the other players in the scene to the action. 

This is referred to as a reaction shot. The reaction shot can be human, animal, or any 

other creature with a perceptible personality. 
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Shade – Mixture of pure colors with only black added. A Shade darkens the color. 

Storyboard Artist Portfolio – Hard or soft document showcasing your visual 

storytelling ability primarily through storyboards. It Include Full Sequences of 

Storyboards. 

Storyboard Panel – Comprised of custom drawings, screenshots from related videos, 

or photos taken on location. 

Swatches – Have a large variety of colors, tints, gradients, and patterns. They allow 

you to compare colors and try different combinations, without any risk. 

Texture – Surface quality in a work of art. We associate textures with the way that 

things look or feel. We describe things as being rough, smooth, silky, shiny, and fuzzy 

and so on. 

Timeline – The Timeline view is where you assemble the timing of your scene's visuals 

and sounds. You can add sound track layers to this timeline, as well as edit audio files 

imported into the sound tracks. You can also add transitions and control the playback 

of a selected panel or the entire storyboard from this view. 

User Interface – The point at which human users interact with a computer, website or 

application. 

Warm color – Generally include magenta, red, orange, yellow, and yellow-green. They 

speed up our perception of time and produce feelings that are warm, cozy, and inviting. 

These colors are associated with excitement, happiness and comfort. 

Wavelength – Distance between the two successive crests or troughs of the light wave. 

It is denoted by Greek letter lambda (λ). 

Zooming in – Make the image of something or someone appear much larger and nearer 

on screen. 

Zooming out – Make the image of something or someone appear much smaller and 

further away on screen. 
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Answer 
 

Module 1. Colors in Storyboarding 

Session 1. Color Basics 

A. Multiple Choice Questions 

1. (d) 2. (a) 3. (b) 4. (c) 5. (c) 6. (c) 7. (c) 8. (b) 9. (b) 10. (a) 

B. Fill in the Blanks 

(1) Visualize (2) Saturation (3) Violet (4) Primary, Tertiary (5) Analogous color (6) 

Contrasting (7) color scheme (8) Visual elements 

C. State True or False 

1. (F) 2. (F) 3. (T) 4. (F) 5. (T) 6. (F) 7. (T) 8. (T) 

 

Session 2. Color Psychology 

A. Multiple Choice Question 

1. (b) 2. (b) 3. (a) 4. (a) 5. (b) 6. (c) 7. (a) 8. (b) 9. (a) 10. (a) 

B. Fill in the Blanks 

(1) Surrounding environment (2) Concentration (3) Stimulating (4) Learning situation 

(4) Yellow (5) Villain (6) Blue-violet (7) Animated 

C. True or False 

1. (T) 2. (T) 3. (F) 4. (T) 5. (T) 6. (F) 7. (T) 

 

Module 2. Digital Storyboarding 

Session 1. Digital Storyboarding Software 

A. Multiple Choice Question 

1. (a) 2. (b) 3. (d) 4. (b) 5. (c) 6. (b) 

B. Fill in the Blanks 

(1) Shot (2) Scene (3) Storyboard (4) Storyboard That (5) online (6) Dialogue, Action 

C. True or False 

1. (F) 2. (F) 3. (T) 4. (T) 5. (F) 

 

Session 2. Digital Storyboarding in Storyboarder 

A. Multiple Choice Questions 

1. (b) 2. (d) 3. (c) 4. (c) 5. (b) 6. (b) 7. (b) 8. (a) 9. (d) 10. (d) 

B. Fill in the Blanks 

(1) Script (2) Opacity (3) Boards (4) Action (5) Final Cut Pro X (6) A or down key (7) 

Light 

C. True or False 

1. (T) 2. (T) 3. (F) 4. (F) 5. (F) 
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Session 3. Digital Storyboarding in Photoshop 

A. Multiple Choice Question 

1. (a) 2.(a) 3.(c) 4.(a) 5.(b) 6.(b) 7.(c) 8.(a) 9.(a) 10.(b) 

B. Fill in the Blanks 

(1) Gradient tool (2) Hand (3) Storyboard (4) 100% (5) Ctrl+ J (6) Ctrl+ N (7) Brush pre-

set 

C. State True or False 

1. (F) 2.(T) 3.(T) 4.(F) 5.(T) 6.(F) 7.(T) 

 

Session 4. Introduction to Toon Boom Storyboard Pro 

A. Multiple Choice Questions 

1. (b) 2. (c) 3. (c) 4. (b) 5. (b) 6. (c) 7. (b) 

B. Fill in the Blanks 

(1) Functionality (2) Camera Size (3) Stage (4) Bitmap (5) Layer (6) Thumbnail 

C. True or False 

1. (F) 2. (T) 3. (T) 4. (F) 5. (T) 

 

Session 5. Digital Storyboarding in Storyboard Pro 

A. Multiple Choice Questions 

1. (c) 2.(a) 3.(b) 4.(b) 5.(a) 6.(b) 7.(a) 8. (b) 

B. Fill in the Blanks 

(1) White Space (2) Background (3) Tools Properties (4) Bitmap (5) Shading, Textures 

(6) Tools (7) Camera transform (8) Audio track 

C. True or False 

1.(T) 2.(T) 3.(T) 4.(F) 5.(F) 6.(T) 7.(T) 

 

Session 6. Colouring Storyboard in Photoshop 

A. Multiple Choice Questions 

1. (a) 2. (a) 3. (b) 4. (b) 5. (d) 6. (d) 

B. Fill in the Blanks 

(1) Coloured (2) One direction (3) Back light (4) Shadow (5) Ctrl+ D (6) Shift+ Ctrl+ I 

C. Select True or False 

1. (F) 2. (T) 3. (T) 4. (T) 5. (T) 6. (F) 

 

Module 3. Roles and Responsibilities of Storyboard Artist 

Session 1. Career opportunities 

A. Multiple Choice Questions 

1. (c) 2. (d) 3. (c) 4. (b) 5. (c) 

B. Fill in the Blanks 
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(1) Storyteller (2) Scriptwriters (3) Visualize (4) Visual continuity (5) Cinematography 

(6) Shot Composition 

C. True or False 

1. (T) 2. (T) 3. (F) 4. (T) 5. (F) 

 

Session 2. Story-boarding for different Media 

A. Multiple Choice Questions 

1. (c) 2. (c) 3. (b) 4. (b) 5. (a) 6. (d) 7. (a) 

B. Fill in the Blanks 

(1) Production (2) Dialogue Recording (3) Storyboard Artist  (4) Pencil (5) Multiple 

People 

C. True or False 

1. (T) 2. (F) 3. (T) 4. (T) 5. (F) 6. (T) 7. (T) 

 

Session 3. Storyboard Case Studies 

A. Multiple Choice Questions 

1. (a) 2. (c) 3. (a) 4. (c) 5. (b) 6. (a) 7. (c) 

B. Fill in the Blanks 

(1) Star Wars: A New Hope (2) Transformer (3) Shading 

C. True or False 

1.(T) 2.(F) 3.(T) 4.(T) 5.(T) 

 

Module 4. Occupational Health and Safety 

Session 1. Safe Working Practices in Work Environment 

A. Multiple Choice Questions 

1. (d) 2. (d) 3. (a) 4. (b) 5. (b) 6. (a) 7. (d) 8. (d) 

B. Fill in the Blanks 

(1) Social (2) Harm (3) Clearly Labeled (4) Poor sitting postures (5) 20 to 30 (6) 

Extinguish Fire (6) Severe or life threatening (7) Immediate help (8) Assistance (9) Safe 

place or hospital 

C True or False 

1. (T) 2. (T) 3. (F) 4. (F) 5. (T) 6. (T) 7. (F) 8. (T) 9. (T) 

 

 

 

 

 

 


